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Introduction
Thank you for purchasing the Inkjet printer Tx330-1800B.
Read this operating manual ("this document" hereinafter) thoroughly and make sure you understand its
contents to ensure safe and correct use of the product.
Please note that the illustrations contained in this manual are intended to show functions, procedures, or
operations and may sometimes differ slightly from the actual machine.
Adobe, the Adobe logo, Acrobat, Illustrator, Photoshop, and PostScript are the trademarks or registered
trademarks of Adobe Incorporated in the United States and other countries.
RasterLink and TxLink are trademarks or registered trademarks of Mimaki Engineering Co. Ltd. in Japan and
other countries.
Other company and product names mentioned herein are the trademarks or registered trademarks of the
respective companies in Japan and in other countries.
Unauthorized reproduction of any portion of this document is strictly prohibited.
© 2025 MIMAKI ENGINEERING Co., Ltd.

l DISCLAIMERS
• MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR DAMAGE ARISING DIRECTLY OR

INDIRECTLY FROM THE USE OF THE Tx330-1800B ("THIS MACHINE" HEREINAFTER), WHETHER
OR NOT THE PRODUCT IS FAULTY.

• MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR DAMAGE, DIRECT OR INDIRECT, TO
MATERIALS CREATED WHILE USING THIS MACHINE.

• USING THIS MACHINE IN CONJUNCTION WITH DEVICES OTHER THAN THOSE RECOMMENDED
BY MIMAKI ENGINEERING MAY RESULT IN FIRE OR ACCIDENTS. SUCH INCIDENTS ARE NOT
COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY FOR
DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

• USE ONLY GENUINE MIMAKI ENGINEERING INK AND MAINTENANCE LIQUID. USE OF OTHER
PRODUCTS MAY RESULT IN FAILURES OR REDUCE PRINT QUALITY. SUCH INCIDENTS ARE
NOT COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY
FOR DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

• DO NOT ATTEMPT TO REFILL THE INK PACKS WITH UNAUTHORIZED INK. SUCH INCIDENTS ARE
NOT COVERED BY THE PRODUCT WARRANTY. MIMAKI ENGINEERING REJECTS ALL LIABILITY
FOR DAMAGE, DIRECT OR INDIRECT, ARISING FROM SUCH INCIDENTS.

l TV and radio interference

• The machine emits high-frequency electromagnetic radiation while operating. Under certain
circumstances, this may result in TV or radio interference. We make no guarantee that this
machine will not affect special radio or TV equipment.

If radio or TV interference occurs, check the radio or TV reception after turning off the machine. If the
interference disappears when the power is turned off, the machine is likely to be the cause of the
interference.
Try any of the following solutions or combinations of these solutions:

• Change the orientation of the TV or radio antenna to find a position where interference does not occur.
• Move the TV or radio away from this machine.

l FCC (Federal Communications Commission) regulations
The machine has been tested and certified to comply with restrictions applying to Class A digital devices
under Part 15 of the FCC regulations. These restrictions are designed to provide suitable protection from
harmful interference when the printer is used in commercial environments.
This product may generate, use, or emit radio frequency energy and may cause harmful interference with
radio communications if not installed or used in accordance with the operating manual.
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Use of this product in residential areas may cause harmful interference. If so, the user is responsible for
rectifying such interference.

• Use only the cables recommended by Mimaki Engineering when connecting to the machine.
Use of other cables may cause the product to exceed the restrictions stipulated by FCC
regulations. To maintain compliance with FCC regulations, use the cables recommended by
Mimaki Engineering.
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To Ensure Safe Use

Symbols
In this manual, symbols indicate and explain precautions. Make sure you fully understand the meaning of
each symbol and use the machine safely and correctly.

Explanation

Warning Indicates a potential hazard that may result in death or serious injury
if handled improperly or if instructions are disregarded.

Caution Indicates a potential hazard that may result in minor or moderate
injury if handled improperly or if instructions are disregarded.

Notice Indicates a potential hazard that may result in property damage if
handled improperly or if instructions are disregarded.

Warning sign Indicates something that requires attention. Warning specifics are
drawn inside the symbol.

Mandatory action
sign

Indicates an action that must be carried out. The specifics of the
mandatory action are drawn inside the symbol.

Prohibition sign Indicates a prohibited action. The specifics of the prohibited action
are drawn inside the symbol.

Important Indicates important information related to use of this machine.

Tip Indicates useful reference information.

Reference
information

Indicates the corresponding page for related information.



To Ensure Safe Use

9

Usage Precautions

l In the event of abnormal conditions

• In the event of abnormal conditions such as smoke or unusual odor, turn off the main power
immediately and turn off the breaker. Continuing to use the machine under these conditions
may result in failure, electric shock, or fire. Once you have confirmed that smoke is no longer
being emitted, contact your local dealer or our service office. Never attempt to repair the
machine yourself, which is hazardous.

• Immediately wipe off any ink, maintenance liquid, waste ink, or other liquid used with the
product that comes into contact with your skin. Then wash using soap, and rinse with plenty of
water. Failure to wash off ink may result in skin inflammation. If your skin becomes irritated or
painful, seek medical attention immediately.

• If ink, maintenance liquid, waste ink, or any other liquid used in the product comes into contact
with your eyes, rinse immediately with plenty of clean water. Rinse for at least 15 minutes. If you
wear contact lenses and they can be easily removed, remove after rinsing for at least 15
minutes with clean water. Be sure to also rinse the undersides of your eyelids. Failure to rinse
off ink may result in blindness or impaired vision. If your eyes become irritated or painful, seek
medical attention immediately.

• If ink, maintenance liquid, waste ink, or any other liquid used in the product enters your mouth or
is swallowed, gargle with water immediately. Do not induce vomiting. Seek medical attention
promptly. Inducing vomiting may cause liquid to enter the airway.

• If a large amount of vapor is inhaled, move to a well-ventilated area, keep warm, and rest in a
posture that allows easy breathing. If the condition does not improve, seek medical attention
promptly.

• If an ink leak occurs, turn off the main power immediately and turn off the breaker. Then, contact
your local dealer or our service office.
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l Power supply precautions

• Do not damage or modify the power cable. Do not place heavy objects on, heat or stretch it.
Doing so may damage the cable, leading to electric shock or fire.

• Do not use the power cable if it is damaged or broken or if the core wire is exposed. Otherwise
there is a risk of failure, electric shock, or fire.

• Always connect the machine to a switchboard with grounded polarity. Otherwise there is a risk
of failure, electric shock, or fire. All electrical work (Class C grounding work; formerly Type 3
grounding work) must be handled by a licensed electrician.

• Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

• Use the machine with a power supply that meets specifications.
• When connecting the power cable, check the input voltage of the power outlet and the capacity

of the breaker. Also, connect each cable to a separate power source with an independent
breaker. Connecting to power outlets linked with the same breaker will cause the breaker to trip.
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l Caution regarding moving parts

• Keep parts of the body such as the face and hands away from moving parts. Also keep clothing
(e.g., loose clothing and accessories) that may impede work away from the machine. Failure to
do so may result in injury.

• Long hair should be tied back. Failure to do so may result in injury.

l Do not disassemble or repair

• Do not attempt to disassemble or repair this machine. Otherwise there is a risk of failure, electric
shock, or fire.

l Other usage precautions

• Keep children away from the machine.

• Do not hold the acrylic part when opening the front cover. Doing so may damage the acrylic.

• The underside of the media may be soiled depending on how the printed media has been stored
(due to weight when laying printed media rolls horizontally, for example) and the media type.
Perform a test beforehand to check that the media does not transfer ink to the underside of the
adjacent media.

• Condensation may form on the print head nozzle surface depending on the ambient
temperature and humidity. The formation of condensation may cause ejection failures (e.g.,
nozzle clogging or deflection). Perform head cleaning if any ejection failures (e.g., nozzle
clogging or deflection) occur during printing.  "Head Cleaning"(P. 91)

l Disposing of the product

• Please contact your local retailer or service agent.
• When disposing of the product yourself, contact an industrial waste disposal operator or dispose

of the product in accordance with local laws and regulations.
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Usage Restrictions

Usage Restrictions

• The machine poses significant safety hazards from parts that move at high speeds. The
machine must only be used by operators who are fully aware of these hazards.

Operator Restrictions

• The machine must only be operated by persons who have received Mimaki safety training or
who have been trained by them.

Area Restrictions

• Persons other than users who have received the appropriate training are prohibited from
approaching the machine. Set area restrictions within the range shown in the following figure.
The area restrictions must make it clear that the area is hazardous. For example, install the
machine in a dedicated room or set up a barrier around it.

• Take steps to keep people other than those who have received Mimaki safety training or who
have been trained by them out of the hazardous area. There is a danger of injury from moving
parts such as the carriage or tension bar while printing is in progress if untrained personnel are
allowed within the restricted area while the machine is operating.

1000 mm or
more

1000 mm or more

1000 mm or
more

Hazardous Area
1000 mm or more

• Physically separate the machine, for example, by placing in a special room or in an area
surrounded by a safety fence. It must be clear that this is a hazardous area.
(1) Any special room provided should incorporate a door that can be locked or has a safety

interlock
(2) Any safety fences used must conform to the EN ISO 13857 standards.
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Notes on Handling Ink or any Other Liquid
Used with the Machine
Precautions regarding ink, maintenance liquid, or other liquids used with this machine are included with the
containers. Thoroughly read them and make sure you understand the contents.

• Be sure to read the safety data sheet (SDS) before use. https://mimaki.com/supply/sds/

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

• Do not subject cases containing ink to strong shock or violent shaking. Do not attempt to refill
the ink. Leaking ink may adhere to the skin or get into your eyes or mouth.

• Do not disassemble cases containing ink. Leaking ink may adhere to the skin or get into your
eyes or mouth.

• Do not store ink, maintenance liquid, or other liquids used with the machine in locations where
children may enter.

• When disposing of ink, maintenance liquid or other liquid used with the product, or containers or
non-woven fabric contaminated with ink or other liquid, contact an industrial waste disposal
operator or dispose of the product in accordance with the local laws and regulations.

• Do not store ink, maintenance liquid, or other liquids used with the machine in locations
exposed to direct sunlight.

• Do not store ink, maintenance liquid, or other liquids used with the machine in environments
where cutting fluid or other volatile substances (such as amines or modified amine alcohol) are
present in significant quantities. Storage in such places increases the risk of failure or ejection
failures (e.g., nozzle clogging or deflection).

• Do not use ink, maintenance liquid, or other liquids used with this machine with other printers.
Doing so may cause failure.

• Be sure to store them in a low place no higher than 1 m above the floor. Otherwise there is a
risk of scattering if the containers fall.

• Store in tightly sealed containers.
• Store in a cool, dark place.

(1) Store ink in a place where ink does not freeze. Using defrosted ink may deteriorate ink
constituents and reduce print quality.

(2) When ink is moved from a cold place to a warm place, leave it in the environment where
the machine is installed for at least three hours before using it.

(3) Open the container just before installing it, and use it up as quickly as possible. If it is
opened and left for an extended period of time, print quality may be reduced.

https://mimaki.com/supply/sds/
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• Do not touch the metal parts of the ink IC chip. Static electricity may damage the ink IC chip,
and dirt or damage may cause the ink IC chip read error.

• Printing is disabled if a different ink IC chip is used.
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Ink Specifications

Item Tx330-1800B

Type Special Dye Sublimation Ink Sb420 (Mimaki
Engineering product)

Special Pigment Trasnfer Ink TP410 (Mimaki
Engineering product)

Color Blue (BL)
Magenta (M)
Yellow (Y)
Black (K)
Light blue (Lbl)
Light magenta (Lm)

Cyan (C)
Magenta (M)
Yellow (Y)
Black (K)
Red (R)
Blue (BL)
Green (GR)
Light black (Lk)

Form Aluminum pack

Ink capacity 2,000 ml

Expiration
date

As indicated on the ink pack. However, after opening, it should be consumed within one
month, even if before the expiration date.

Stora
ge
temp
eratu
re*1

Whe
n
store
d

10 to 35 °C (daily mean temperature)

Durin
g
trans
porta
tion

0 to 40 °C

*1. Ink quality may deteriorate if stored outside this temperature range.
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Restrictions Concerning the Expiration Date of Ink Used in the
Machine

Example: When the expiration date is April 20xx
• May 20xx: Replace with new ink or use up as quickly as possible. Printing is possible.
• June 20xx: Replace with new ink or use up as quickly as possible. Printing is possible.
• July 20xx: Printing is not possible.

• The message appears on the display.

• The ink expiration date is indicated on the ink container. Expired ink may cause ejection failures
or alter the color tone. Printing is possible even if the ink has passed its expiration date.
Nevertheless, we recommend replacing with new ink or using up as quickly as possible.

Restrictions Concerning Ink Set Changes
When filling with ink sets other than Sb420 (Sb420_4C/6C), specifically, with TP410_4C/8C, or hybrid ink
Sb420/TP410, the following options are required separately from the main unit. (The same applies when
changing to a different type of ink set.)

Type Ink set Option no.

A Sb420 4C/6C None (not required)

B TP410_4C OPT-01007

C TP410_8C OPT-01008

D (hybrid) Sb420/TP410 OPT-01010
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Installation Precautions

• Adhesive and releasing agents may contain flammable constituents such as thinner. This
machine is not explosion proof. There is a risk of explosions.

• Do not install the machine in a place close to fire.
• Do not place flower vases, pots, cups, containers containing cosmetics, chemicals or water, or

small metal items on or close to the machine. If they enter the machine, there is a risk of failure,
electric shock, or fire.

• Do not install this machine in humid locations or locations where it may be exposed to splashing
water. Otherwise there is a risk of failure, electric shock, or fire.

• Do not install the machine in a place where children may enter.

• A ventilation system must be provided if the machine is installed in a poorly ventilated area or
sealed room.

• Be sure to observe the following points regarding exhaust port installation:
(1) Exhaust port installation must conform to local environmental, health, and safety (EHS)

guidelines.
(2) If the exhaust port is fitted with a shutoff valve, the valve must be open when the machine

is in use.

• Do not install this machine in locations where dust or powder is present. Failure or printing
defects may result (e.g., nozzle clogging, deflection) if dust gets inside this machine.

• Do not install this machine in locations exposed to drafts (e.g., from air conditioning).
Disregarding this precaution may result in dust or powder getting inside this machine.

• Do not install this machine in unstable locations or locations subject to vibration. This will
increase the risk of failure or printing defects (e.g., nozzle clogging, deflection).

• Do not install this machine in locations exposed to direct sunlight.
• Do not install this machine in locations subject to sudden temperature changes. This will

increase the risk of failure or printing defects (e.g., nozzle clogging, deflection).
• Do not install this machine in locations exposed to excessive noise from large machinery.
• Do not install this machine in locations where photographic fixing agents generate vapor or acid

gas (e.g., acetic acid, hydrochloric acid) or locations filled with metal working fluids or highly
volatile substances (e.g., amines, amine-modified alcohols). Malfunctions or printing defects
may result (e.g., nozzle clogging, deflection) as print head ink is more likely to harden under
such environments.

• Operating environment: 20 to 30 °C (68 to 86 °F), 35 to 65 %RH (no condensation)
• Temperature range in which accuracy is guaranteed: 20 to 25 °C (68 to 77 °F)
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Installation Space
Provide the following space around the machine to allow safe and proper replacement of ink and media:

Installation space (width)

Installation space (fro
nt to

 rear)

1000 mm or m
ore

1000 mm or m
ore

500 mm or more

500 mm or more

l Tx330-1800B
Size Tx330-1800B

Width*1 At least 4,230 mm (3,230 mm)

Depth*1 At least 3,912 mm (1,912 mm)

Height*1 (1,900 mm)*2

Weight 622 kg

*1. The figures in parentheses indicate machine dimensions.
*2. With ink eco-cases loaded.

When Relocating This Machine
Contact your local dealer or our service office. Attempting to handle relocation yourself may result in failure
or damage.



Safety Interlocks

19

Safety Interlocks
The machine is equipped with interlocks to ensure safety during use.
Printing will abort if you open the covers while printing is underway. The RIP data will need to be resent.

• Safety interlock locations
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Emergency Stop Switches
Press one of the switches to stop the machine immediately for safety. Two emergency stop switches are
located at the front of the machine and two at the rear.

Front Rear

• Do the following after an emergency stop switch has been pressed.
(1) Unplug the machine from the power outlet and resolve the problem.
(2) After confirming safety, deactivate the emergency stop switch.

(3) Plug the machine into the power outlet.
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Warning Label
Make sure you fully understand the details indicated on the various warning labels.
If any of the warning labels becomes dirty and illegible or peel off, contact your local dealer or our service
office to request new warning labels.

3

1

3

4

7

5

6
8

8

2
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No. Order code Label Details

1 M910931 Beware of opening and closing
parts. Injury may result if hands
become trapped.

2 M907833 Indicates dangerous moving parts.

3 M903330 Wear safety glasses and gloves
while working.

4 M913867 Indicates dangerous moving parts.

5 M913939 Indicates dangerous moving parts.

6 M905811 Indicates dangerous moving parts.

7 M907935 Indicates dangerous live parts.

8 M918910 Indicates dangerous moving parts.
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1.1 Part Names and Functions

Front

3

5

6

3

1

10

11

13

7

8

2

4

9

12

14

No. Name Overview

1 Ink Supply Unit Each tank contains an ink of a particular color.  "Ink Supply Unit"(P. 27)

2 Front cover Open the cover to load media or replace consumables. Printing and 
automatic maintenance are not possible while the covers are open.

3 Maintenance cover Open the cover to perform maintenance on locations such as the carriage
underside. Printing and automatic maintenance are not possible while the
covers are open.

4 Carriage Consists of components such as the print head and jam sensor. 
"Carriage"(P. 28)

5 Operating Panel Includes operating keys and displays indicating various settings and other
items.  "Operating Panel"(P. 30)

6 Station Includes caps and wipers for protecting print heads.  "Station"(P. 28)

7 Waste Ink Tank Container for waste ink.  "Waste Ink Tank Replacement"(P. 163)

8 Water supply valve Valve for supplying washing water. The valve opens and closes
automatically, but the water supply can be adjusted with a cock if necessary.

 "Washing Water Replacement"(P. 130)

9 Belt Washing Unit Cleans the feeding belt.  "Cleaning the Feeding Belt"(P. 147)

10 Take-up unit Rolls up the printed roll media.  "Take-up unit"(P. 56)

11 Doctor Used when reapplying adhesive.  "Reapplying Adhesive"(P. 136)

12 Peeling roller Peels cloth media from the feeding belt.  "Loading media when using
peeling"(P. 78)
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No. Name Overview

13 Cloth-wound roller Helps keep cloth media clean by removing any ink on the peeling roller. 
"Setting Up the Fabric Roller"(P. 53)

14 Feeding belt Feeds cloth media.  "Cleaning the Feeding Belt"(P. 147)

1
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Rear and Right Side View

1

5
4

2

9

10

11

12

13

8

7

3

6

No. Name Overview

1 Blowing fan Blows air to dry ink after printing.  "Blowing Fan Filter
Replacement"(P. 161)

2 Pressure roller Applies pressure to keep media adhering to the feeding belt.

3 Cloth-wound roller Helps keep cloth media clean by removing any ink on the feeding belt. 
"Setting Up the Fabric Roller"(P. 53)

4 Curved bar Makes sagging cloth media taut.  "Using the curved bar to make sagging
media taut"(P. 83)

5 Smoothing roller Smooths wrinkled cloth media.  "Removing the smoothing roller and
shifting coils"(P. 84)

6 Reversing bar Stabilizes feeding tension of media.  "Adjusting the reversing
bars"(P. 76)

7 Feeding tension bar Adjusts feeding tension of media.  "Using the tension bars"(P. 66)

8 Feeding unit Feeds roll media toward the front of the machine.  "Feeding unit"(P. 60)

9 Maintenance liquid
cartridge

Used to automatically feed maintenance liquid to the cap, and to prevent ink
solidifying inside the ink discharge channel during maintenance.

10 USB port Connects to PC via a USB interface cable.  "Using a USB Cable"(P. 37)

11 LAN port Connects to PC via a LAN cable.  "Using a LAN Cable"(P. 36)

12 Main power switch The main power supply for the machine. To prevent ejection failures
attributable to the print head (e.g., nozzle clogging or deflection), do not turn
off the main power supply.  "Power Supply Switch"(P. 29)  "Turning
On the Power"(P. 33)  "Turning Off the Power"(P. 34)

13 AC inlet Use the power cable provided.  "Connecting the Power Cable"(P. 33)
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Ink Supply Unit

1

4

2

3

No. Name Overview

1 Ink Eco-case The ink eco-cases are mounted here.  "Mounting the ink"(P. 45)

2 Ink lever Push down the lever to remove the ink eco-cases.

3 Ink IC chip slot Insert the ink IC chips provided with the ink. This manages the ink
information.

4 Ink leak check tube When ink is in the tube, contact your local distributor, our sales office, or
service center. .

1
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Carriage
The carriage includes a print head for ejecting ink, and a jam sensor for stopping the carriage when media
clogs. Printing occurs as ink is ejected while traversing left and right.

Station
The station includes a cap for preventing the print head nozzle surface from drying out, and a wiper required
for print head maintenance.

Wiper

NCU

Cap
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Power Supply Switch

l Main power switch
This is located at the rear on the right-hand side of the product.

Main power switch

• Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

l [END/POWER] key
The [END/POWER] key is the key normally used to turn the power on and off.
To turn off the power, hold down the [END/POWER] key. Press the [ENTER] key once the instructions
appear on the display.

[END/POWER] key

1
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Operating Panel
This is used to control the product and make/change settings.

REMOTEMENU
TEST PRINT

CLEANING

xxxx

1

2 3

4

5 6

7

No. Name Overview

1 Display  "Display"(P. 31)

2 [SEL] key Selects the function for the corresponding [FUNCTION] key.

3 [FUNCTION] key Used for test printing, head cleaning, and editing settings.  "[FUNCTION]
key"(P. 32)

4 [JOG] key Used to move the carriage, feed media, and select settings

5 [END/POWER]
key

Used to cancel the last setting entered, return to the previous level of the setting
menu, or to turn power on and off

• Illuminates in blue when the power is on.  "Turning On the Power"(P. 33)
• To turn off the power, hold down the key.  "Turning Off the Power"(P. 34)

6 [ENTER] key Used to move to the next level menu and to confirm settings. This can also be
used to display product information.  "Displaying Machine Information (Local
Guidance)"(P. 32)

7 Status lamp This lamp indicates the machine status.

Off Indicates LOCAL mode. Used for test printing, maintenance,
and settings

Light
blue

Illumina
ted

Indicates REMOTE mode. The product is in standby to receive
print data.

Flashin
g

Indicates that printing is in progress. This also flashes to
indicate test printing—for example, when printing built-in
patterns.

Blue Illumina
ted

Indicates that data remains to be printed. Switch to REMOTE
mode and start printing

Green Flashin
g

Indicates that maintenance is underway. Some functions will
be limited until maintenance has ended.

Yellow Flashin
g

Ink Near End status (very little ink remains).  "When Ink
Near End is Displayed"(P. 41)

Red Flashin
g

An error has occurred. Refer to the error code list and take
appropriate action. Error Message

Illumina
ted

A system error (SYSTEM HALT) has occurred. Contact our
service office.  "SYSTEM HALT"(P. 178)
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Display

PRE PRINT POST

35°/40° 40°/40° OFF

REMOTE
TEST PRINT

CLEANING
MENU

LOW 1620mm

SETUP 1 Connected cable type

Detected media width

Function name assigned to
[FUNCTION] key

MENU mode <setting type number>

Head height

Ink status

MENU mode
Four menu modes are available.

Name Overview

LOCAL mode Used for test printing, maintenance, and settings

REMOTE mode Prints the print data received from a PC.

MENU mode Press the [MENU] on the LOCAL mode screen to switch to MENU
mode. This is used to set various functions.

NOT-READY mode Status before media is detected

Ink status
The ink pack status such as remaining ink levels and ink errors are indicated by icons.

Icon Overview

Displays remaining ink levels using a 9-stage icon.

Full 1/8 used 1/4 used 3/8 used 1/2 used 5/8 used 3/4 used 7/8 used

Very little ink remains. Prepare fresh ink.

Printing is not possible. Displayed when ink is depleted or an ink error has occurred.  "Ink
Error"(P. 171)

1
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[FUNCTION] key
This section describes the functions and roles assigned to the [FUNCTION] key.

Icon Overview

Displays the various menu screens.  "Setup"(P. 101)

Displays maintenance functions such as test printing and cleaning.

Switches from LOCAL mode to REMOTE mode.

Displays adjustment functions such as feed adjustment and drop position adjustment.

Displays the Heater Temperature Setup screen.

Clears received data.

Used to switch from REMOTE mode to LOCAL mode

Used to move to the previous menu screen

Used to move to the next menu screen

Used to close the confirmation screen in response to prompts or other messages

Used to disable functions

Indicates that the function is assigned. Displays settings and functions.

Used to enable or disable multiple items

Displaying Machine Information (Local Guidance)
Press the [ENTER] key on the LOCAL mode screen to display the following information.

• Ink information: Displays ink type, remaining ink levels, and ink errors.
• Information: Displays information such as media width, head height, product serial number, firmware

version, command version, and LAN connection status.
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1.2 Connecting the Power Cable
1 Check to confirm that the main power supply is turned off.

2 Connect the cable band to the machine.

3 Connect the power cable to the inlet of the machine.

4 Secure the power cable to the cable band.

• Pass the power cable through the clamp and clamp until it clicks into place.

Cable band

Power cable

5 Plug the power plug into the power outlet.

Power plug

Power outlet

• Do not handle the power plug with wet hands. Disregarding this precaution may result in
electric shock.

Turning On the Power

1 Check to confirm that the main power supply is turned on.

• If the main power supply switch is not turned on, set to "I".

Main power switch

1
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2 Press the [END/POWER] key to turn on power.

• The firmware version appears on the display, and the initial operation is executed. The machine
will then enter the Media Select mode, and is ready for use.

[END/POWER] key

3 Turn on the power for the connected PC.

• Close the front cover and maintenance covers. Leaving any of the covers open will disable the
automatic maintenance function (including nozzle clogging prevention function and waste ink
draining channel cleaning function). This will increase the risk of failure or ejection failures (e.g.,
nozzle clogging or deflection).

Turning Off the Power

• Check the following when turning off power:
(1) The front cover and maintenance covers are closed.

• Leaving any of the covers open will disable the automatic maintenance function (including
nozzle clogging prevention function and waste ink draining channel cleaning function).

(2) The carriage has returned to the capping station.
• If not, the print head nozzle may dry out, resulting in ejection failures (such as nozzle

clogging or deflection).
(3) Data is not being received
(4) No errors have occurred.

•  "Problems Causing Messages to Appear"(P. 169)

1 Turn off the power to the PC connected.

2 Hold down the [END/ POWER] key.

• A power off confirmation screen appears. Press the [ENTER] key to turn the power off.

[END/POWER] key
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• Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

1
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1.3 Connecting a PC to the Product
Connect the machine to the RIP PC. The following cables can be used:
1.  "Using a LAN Cable"(P. 36) (Recommended)
2.  "Using a USB Cable"(P. 37)

When using the USB cable
• Data may be transferred to the machine too slowly, causing the carriage to pause at the left-

hand or right-hand end during printing.

Using a LAN Cable
Connect a PC to this product using a LAN cable. Insert a LAN cable until it engages with a click.

• Do not unplug the cable while data is being transferred.

l Network Connection Precautions
Make sure the network is set up as follows: Printing is not possible if the network is not set up correctly.

• Use a Category 6 or higher LAN cable.
• The PC used to transfer print data must be located on the same network as this product. This product

cannot be connected via a router.
• Use a 1000BASE-T compatible computer or switching hub. Printing requires 1000BASE-T support.

Switching hub

l Checking the LAN connection

1 Check the display on this product.

• Local guidance can be used for checking.  "Displaying Machine Information (Local
Guidance)"(P. 32) Printing is not possible if "100Mbps", "10Mbps", or "No Connect" is displayed.

INFORMATION

LAN Status 1000Mbps

2 Check the lamp on the LAN connector.

• The LAN connector lamp illuminates when the machine is running.
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Color Status Overview

Green Illuminated Connected via 1000BASE-T

Off Connected via a network other than 1000BASE-T
• 1,000 Mbps is not supported if only the orange lamp is illuminated or

flashing. Check the specifications for the PC, peripheral devices, and
cable.

Orange Illuminated Linked up (connected).

Flashing Data being received

Off Link down (not connected)

Using a USB Cable
Connect a PC to this product using a USB interface cable.

• Do not unplug the cable while data is being transferred.

• Use RIP software that supports the USB interface.

• If the computer has no USB port, contact your local dealer or our service office.

When using the USB cable
• Data may be transferred to the machine too slowly, causing the carriage to pause at the left-

hand or right-hand end during printing.

l USB Connection Precautions
• When connecting more than one Tx330-1800B to a PC

– If the PC has more than one USB port, try connecting to a different USB port to check whether the
product is correctly recognized. If the product is still unrecognized even when connected to a
different USB port, use a commercially-available USB active repeater cable.

• When extending the USB cable
– Use a commercially-available USB active repeater cable. However, make sure that the combined

length of the USB cable and the USB active repeater cable does not exceed 20 m.
– If the USB cable is extended, this may reduce the data transfer speed to the machine, causing the

carriage to pause at the left-hand or right-hand end during printing.
• USB high-speed mode peripheral devices

– It may not be possible to recognize USB peripheral devices if USB high-speed mode peripheral
devices (e.g., USB memory, USB HDD devices) are connected to the PC to which the product is
connected. If external USB hard disk drives or other similar devices are connected, this may reduce
the data transfer speed to the machine, causing the carriage to pause at the left-hand or right-hand
end during printing.

• Unplugging USB memory devices
– When unplugging USB memory devices from the PC to which this product is connected, use "Stop"

in "Safely removing hardware" before unplugging. Otherwise, an [ERROR 201 Command Error] will
occur.

1
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1.4 System Configuration
Use RIP software to request to print data created using applications like Illustrator or Photoshop.

Preparing RIP Data

[Ethernet connection]
RIP-PC

Print request

[Local network]

Receiving Print Data
Generating RIP Data
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Installing the Mimaki Driver

1 Download the  Mimaki driver from our website.

• https://mimaki.com/download/inkjet.html
[Tx330-1800B] > [Driver/Utility]

2 Install the MIMAKI driver.

Installing RIP Software
The explanation here applies to MIMAKI RIP software (RasterLink).

• If using TxLink, refer to the TxLink operating manual.

1 Install RasterLink.

• The following icon appears on the PC desktop once the software has been installed.

• For more information, refer to the RasterLink installation guide. https://mimaki.com/download/
software.html

• Once installed, activate the license for Rasterlink. Otherwise, "Profile Update" will not start.

Obtaining Color Profiles
Print quality (e.g., tone, bleeding) will vary depending on the media and ink set. To maintain consistent print
quality, select a color profile that suits the media and ink set.

• The RasterLink Series includes a function allowing color profiles to be downloaded and installed directly
from the Internet. For more information, refer to "Installing Profiles" in the RasterLink Series installation
guide. 
https://mimaki.com/download/software.html
[RasterLink Series used] > [Manuals]

• Color profiles for Mimaki RIP software (RasterLink) are available on the Mimaki website. 
https://mimaki.com/download/inkjet.html
[Tx330-1800B] > [Profile]

Setting Up RIP Software
The explanation here applies to MIMAKI RIP software (RasterLink).

• If using TxLink, refer to the TxLink operating manual.

1 Launch RasterLink.

• The [Printer Management] screen appears.
• To add a new model, launch RasterLink, then select [Environment] > [Printer Management].

1

https://mimaki.com/download/inkjet.html
https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
https://mimaki.com/download/inkjet.html
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2 Register Tx330-1800B.

(1) Click [Add].

(2) Set the specifics for Tx330-1800B.

• Model: Select the model. 
For models using normal ink sets, select [Tx330]. For models using 
hybrid ink sets, select [Tx330-Hybrid].

• Color: Select the ink set filled.
• Output Port: Select the cable connected.
• Available Printers: Select Tx330-1800B connected.
• Printer: Enter a name as required.

(3) Click [OK].
• A confirmation screen appears.

(4) Click [Yes].
• Printer registration starts.

• For more information, refer to the RasterLink installation guide. https://mimaki.com/download/
software.html

https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
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1.5 Ink Replacement Method

When Ink Near End is Displayed
Ink levels are low. We recommend replacing with new ink as soon as possible, because the ink packs are
nearly empty. Printing is still possible but continuous printing is not, and some maintenance functions such
as cleaning are disabled. Note that ink may run out during printing.
To check which color ink needs to be replaced, press the [ENTER] key on the LOCAL mode screen. 
"Displaying Machine Information (Local Guidance)"(P. 32)

When Ink End is Displayed
The ink has run out. Replace with new ink.
Thoroughly read the following and make sure you understand its contents.

 "Notes on Handling Ink or any Other Liquid Used with the Machine"(P. 13)

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

1
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Replacing Ink

Ink replacement procedure

l Removing Ink Eco-cases

1 Push down the lever on the pedestal, and remove the ink Eco-case.

2 Open the ink eco-case, then remove the ink pack.

3 Remove the ink IC chip.
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4 Wipe off any ink adhering to the ink eco-case opening.

• Check to confirm no foreign matter such as dust or paper towel matter is adhered to the
opening. If foreign matter is present, this may block the ink path and lead to leakage.

• We recommend replacing the ink absorber each time you replace the ink pack, to prevent dirt
building up on the pedestal of the ink supply unit.

• When disposing of ink, maintenance liquid or other liquid used with the product, or the container
or paper towel to which ink or other liquid is attached, contact an industrial waste disposal
operator or dispose of the product in accordance with the local laws and regulations.

l Preparing the Ink

1 Pull out the ink pack and ink IC chip from the ink package.

Ink pack

Ink IC chip

1
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2 Shake the ink pack to the left and right slowly at least 20 times.

• Shake the bottle slowly from left to right to ensure that the ink moves inside, holding the ink pack
opening with a paper towel.

Repeat

• When using an ink pack with ink remaining, hold a paper towel over the ink eco-case
opening and shake slowly with the ink eco-case tilted upright.

3 Remove the seal attached to the ink pack opening.

• Remove the seal completely. If any parts of the seal remain, ink may leak when the ink
eco-case is removed from the base.

OK No good

4 Place the ink pack inside the ink eco-case.

• Push the ink pack connector into the ink eco-case slot. Ink may not be supplied if the connector is
out of position.

• Position the pack as indicated on the label on the ink eco-case.

Seal

Ink pack

Slot

5 Close the ink eco-case gently to avoid pinching the ink pack.

• Be careful to avoid catching your hands or fingers.
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l Mounting the ink
The order of the ink eco-cases to be set varies depending on the ink set you are currently using. Check the
ink slot numbers, then insert the correct color ink eco-cases.

11
22
33
44
55
66
77
88

Ink set Ink positions

1 2 3 4 5 6 7 8

Sb420 (4-color) M M Y Y Bl Bl Bk Bk

Sb420 (6-color) M Lm Y Lb Bl Bl Bk Bk

TP410 (4-color) M M C C Bk Y Bk Y

TP410 (8-color) M R C Bl Lk G Bk Y

Sb420/TP410
(4-color, hybrid)

Sb420 TP410

M Y Bl Bk M C Bk Y

1 Set an eco-case on the base.

• Fully push in the eco-case. Otherwise, ink may not be fed properly.

1
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2 Insert the new ink IC chip into the ink IC chip slot.

• Insert the ink IC chip with the metal side facing up. Inserting it in the wrong way may
cause failure of the machine or damage the ink IC chip.

• Do not touch the metal parts of the ink IC chip. Static electricity may damage the ink IC
chip, and dirt or damage may cause the ink IC chip read error.

• Ink IC chips: The marking on the ink IC chip indicates the color information.

Marking location

Ink Color Marking

Cyan  (One blue circle)

Magenta  (One red circle)

Yellow  (One yellow circle)

Black  (One black circle)

Light cyan  (Two blue circles)

Light magenta  (Two red circles)

Light black  (Two black circles)

Orange  (One orange circle)

White  (One white circle)

Blue  (One blue circle/one red circle)

Light blue  (Two blue circles/one red circle)

Red  (One red circle/one yellow circle)

Green  (One green circle)

• Insert the ink IC chip included in the package with the ink. The ink IC chip stores information
such as the ink color, remaining amount, and expiration date. Printing is not possible if an
incorrect ink IC chip is inserted.
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2.1 Print Process

1. Turn on the power.

 "Turning On the Power"(P. 33)

[END/POWER] key

2. Connect a RIP PC to the machine.

 "Using a USB Cable"(P. 37)
 "Using a LAN Cable"(P. 36)

3. Setting Up RIP Software

 "Installing RIP Software"(P. 39) (required first time only)
 "Obtaining Color Profiles"(P. 39)
 "Setting Up RIP Software"(P. 39) (required first time only)

4. Adjusting Print Head Height

Adjust the height adjustment lever to suit the media.  "Adjusting Print Head Height"(P. 51)

Height adjustment lever

Low

High

5. Setting Up the Cloth-wound Roller (Two Positions)

 "Setting Up the Fabric Roller"(P. 53)
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6. Loading the Media

 "Loading the Media"(P. 55)

7. Check the state of the print head nozzles.

 "Test Printing"(P. 89)

Good example Bad example

Nozzle Deflection Nozzle clogging

8. Clean the head to clear malfunctioning nozzles.

There are three different head cleaning methods. Choose the head cleaning method based on test print
results.  "Head Cleaning"(P. 91)

9. Adjust the media feed amount.

 "Feed Correction"(P. 92)

Second band

First band

Good example Bad example

10. Adjust the drop position for bi-directional printing.

 "Correcting the Drop Position"(P. 94)

In this case, the drop position correction value will be "+4.0".

Media feed direction

11. Preparing RIP data

 "Preparing RIP data"(P. 96)

2
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12. Printing RIP data

 "Printing"(P. 98)
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2.2 Adjusting Print Head Height
Adjust the height of the print head according to the thickness of the media you are using.

• Be sure to correct the dot position after altering the print head height.  "Correcting the Drop
Position"(P. 94)

• With inkjet printers, if the gap between the print head and media increases, the ink droplets tend
to vaporize before they reach the media. Vaporized ink may adhere to the print head nozzle
surface and media, affecting print quality and causing failure of the print head. Adjust the print
head height to suit the media.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the feeding belt.

3 Open the front cover.

4 Use the height adjustment lever to adjust the height.

• Set the height adjustment lever so that the desired height is at the top. If the lever is not
set to the correct position, problems such as media jamming and misting may occur,
resulting in impaired print quality.

• When doing this at High, be careful not to push the lever too far to the rear.

Height adjustment lever

Low

High

Low Low-Middle Middle Middle-High High

Low
Low-Middle

Middle
Middle-High

High

Height adjustment lever

Range
High

Low
Low-Middle

Middle
Middle-High

(1) Gap between print head and feeding belt(2) Recommended media thickness
7.0 mm
6.0 mm
5.0 mm

3.0 mm (default setting)
4.0 mm

3.5 mm to 5.0 mm
2.0 mm to 4.0 mm
1.0 mm to 3.0 mm

2.0 mm or less
1.0 mm or less Platen

Print head

(1)

(2)

Media
Feeding belt

5 Once adjustment is complete, close the cover, then press the [ENTER] key.

2
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• Check the head height indicated on the display. Readjust the height using the height
adjustment lever if it is not at the set height.

PRE PRINT POST

35°/40° 40°/40° OFF

REMOTE
TEST PRINT

CLEANING
MENU

LOW 1620mm

SETUP 1

Head height
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2.3 Setting Up the Fabric Roller
When printing on to coarse cloth, ink remaining on the back of the cloth may adhere to the peeling roller and
dirty the cloth media. 
Attaching the cloth-wound roller helps to prevent the cloth media from becoming dirty by removing any ink
adhering to the peeling roller.

• The fabric roller is not shipped with cloth wound on it. Prepare suitably absorbent cloth that
meets the following conditions.

• Adjust the length etc., to suit the cloth used. (Make sure that the cloth-wound roller is in contact
with the peeling roller at the center and ends.)
(1) Material: Cotton jersey, cotton broadcloth, etc.
(2) Size: 195 cm × 70 cm (approximate)

1 Remove the fabric wound roller.

• One cloth-wound roller is below the peeling roller in the front of the machine and another is used in
contact with the belt surface in the back.

Peeling roller Cloth-wound roller Cloth-wound roller

Front Rear

2
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2 Wind cloth around the fabric roller.

(1) Align the cloth with the roller.

195cm

70cm

Cloth-wound roller

(2) Secure the cloth to the roller with adhesive tape.

Tape

(3) Wind the cloth around the roller, then secure with adhesive tape.

3 Attach the fabric roller with the cloth wound on it.

• Mount the fabric roller in the groove below the bracket.
• Adjust the positions of the bearings at both ends of the fabric roller. 

Loosen the bearing screws and adjust so that the fabric roller touches the peeling roller.

Screw

Cloth-wound roller Cloth-wound roller

Front Rear

Screw

• Clamp in place so that the cloth-wound roller is in contact with the peeling roller at the
center and both ends. 
If the rollers are not in contact at the center and both ends, the size of the cloth wound on
to the fabric roller should be changed accordingly.

4 Rotate the peeling roller by hand to confirm that it turns smoothly.

• If the peeling roller does not turn smoothly, check the mounting position of the cloth-wound roller.
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2.4 Loading the Media
• Adjust the head height before loading media. Moving the carriage after the media has been

loaded may result in the print head coming into contact with the media and being damaged.

Media

l Media handling precautions

• Use Mimaki-approved media to ensure consistent high-quality printing.

• Assign at least two persons to load roll media. (Assign up to six persons to this task depending
on the media weight.)

• When loading roll media, be careful to avoid dropping it on your feet. Also be careful to avoid
catching your fingers. Disregarding this precaution may result in injury due to the weight of
media.

• When using a lifter to load media, prepare a suitable one by checking the specifications.

• Do not leave the media in the machine when not in use. Otherwise dust may accumulate on the
media. Do not use media that has been wiped free of dust. Wiping media can generate static
electricity, possibly affecting print quality.

• Do not use media immediately after removing it from the package. The media may expand or
contract depending on the temperature and humidity of the location in which it was stored. Allow
the media to stand for at least 24 hours in the same indoor environment as the machine before
loading it.

• Do not use media if it is curled. Curled media may not only damage the print head, but may also
affect print quality.

• Avoid storing unopened media in hot or humid places, or in direct sunlight.
• After opening, be careful not to touch the surface (especially the printing surface).

2
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Take-up unit
Use the switch on the take-up unit to change the media take-up direction.

Direction selector switch On/off button

Name Overview

Direction
selector switch

Up (reverse) Taken up with the printed surface inside

Down (forward) Taken up with the printed surface outside

On/off button Activates/deactivates take-up.
• With a torque limiter attached: Pressing the button activates the take-up unit, which

continues the take-up operation until you press the button again. *1

• With a direct-connection unit attached: Activates take-up only while the button is
pressed.

*1. If you want to configure settings so that the feeding operation is performed only while you are pressing the
on/off button, use the feeding/take-up switch settings in the options for roll unit selection. With setup menu
margins set to the minimum (5 mm) on either side.  "Function Setting Menu"(P. 109)

Replacing the direct-connection unit/torque limiter
The take-up unit should be replaced with a direct-connection unit when the peeling function is used, or with a
torque limiter when it is not used. 
The feeding unit should be replaced with a direct-connection unit when tension bars are used, or with a
torque limiter when they are not used. 
The torque limiter can change the strength of feeding/take-up operations. (As shipped, the torque limiter is
set to medium.) 
Reduce the level of this setting if there is too much tension for lightweight media.

l Torque limiter attachment
For media take-up without using tension bars, the direct-connection unit must be replaced with the torque
limiter.

1 Remove the direct-connection unit.

• Remove the knob screw, then remove the direct-connection unit.

Direct-connection unit

Knob screws
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2 Attach the torque limiter.

(1) Insert the torque limiter.

Torque limiter

(2) Attach the torque limiter so that the surface is flush with the end of the feeding/take-up unit
shaft, as shown.
• Efficient media take-up is not possible unless the end of the shaft and the torque limiter

surface are flush.

Torque limiter

Shaft

Attach so that the end of the shaft and surface are flush

(3) Tighten the knob screw to secure the torque limiter.

Knob screws

l Direct-connection unit attachment
Also refer to the instructions for torque limiter replacement when replacing the torque limiter with the direct-
connection unit.

• Attach the direct-connection unit so that the lug on it is aligned with the groove of the feeding/
take-up unit.

Groove Projection

2
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Adjusting the torque limiter
Turn the torque limiter adjustment nut to adjust take-up tension. When adjusting the torque limiters, be sure
to adjust to the same torque for both the left and right take-up units.

Adjustment nut

Torque scale

Mid (recommended) MaxMin

• For normal printing: Adjust the torque to "Mid".

l Increase tension (clockwise)
Increase tension when using with heavy or thick media, such as tarpaulin. Perform adjustments manually.

• Do not use the torque adjustment handle. Using the torque adjustment handle will cause
overtightening. Overtightening may damage the take-up unit.

l Decrease tension (counterclockwise).
Decrease tension when using lightweight media. Use the "torque adjustment handle" provided.
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Removing the roll media after printing

l Procedure

1 Cut the media.

• Use scissors or the like to cut away the printed portion.

2 Use the switch on the take-up unit to take up the printed media.

• For instructions on the take-up unit, refer to  "Take-up unit"(P. 56).

2
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Feeding unit
The switches on the feeding unit can be used to change the media feed direction.

Direction selector switch On/off button

Name Overview

Direction
selector switch

Up (reverse) • With a torque limiter attached: To apply tension to media printed
on the outer surface, without using a tension bar.

• With a direct-connection unit attached: To feed media printed on
the inner surface, using the tension bar.

Down (forward) • With a torque limiter attached: To apply tension to media printed
on the inner surface, without using a tension bar.

• With a direct-connection unit attached: To feed media printed on
the outer surface, using the tension bar.

On/off button Activates/deactivates feeding.
• With a torque limiter attached: Pressing the button activates the feeding unit, which

continues the feeding operation until you press the button again. *1

• With a direct-connection unit attached: Activates feeding only while the button is
pressed.

*1. If you want to configure settings so that the feeding operation is performed only while you are pressing the
on/off button, use the feeding/take-up switch settings in the options for roll unit selection.  "Function
Setting Menu"(P. 109)

Adjusting tension bar weight
Various types of media are available which feature a variety of thread thicknesses and are woven in different
ways. Even with the same media, elasticity varies depending on pretreatment and other factors. To ensure
correct tension when printing on such diverse media, the take-up tension bar must be weighted correctly
using tension bar weights and weight-adjustment springs, and reversing bars must be mounted in the correct
positions.

l Counterweights and weight-adjustment springs
You can adjust the weight of tension bars based on where you attach counterweights and how you attach
weight-adjustment springs.
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• Load the media as described in  "Loading the Roll Media"(P. 66) before attaching
counterweights or springs.

Check this side.

Media/printing conditions Action

• The print surface is tautly tensioned.
• Printing is consistent.
• Minimal sagging or wrinkling is seen in the

media.

The media is correctly tensioned. No weight
adjustment is required for the tension bar.

• Wrinkling occurs in the media feed direction.
• The media meanders during printing.
• The tension bar does not rise or the paper core

slips.

The media is excessively tensioned. Reduce the
counterweights to reduce the weight on the tension
bar to suit the media being used.

• The media sags and is not taken up smoothly.
• The media sags and the surface is not flat.

The media is insufficiently tensioned. Increase the
counterweights to increase the weight on the tension
bar to suit the media being used.

Counterweights
• The machine is not shipped with counterweights attached.
• A maximum of 700 g can be attached at each position. Check the media tension and attach a

suitable amount of weight.
• Counterweights can be attached at two places on the feeding side (left and right). Attach the

same amount of weight at each position. Uneven weighting may bend tension bars and affect
print quality.

• Keep unused counterweights in the box to avoid losing them.

Weight-adjustment springs
• The machine is shipped with the green spring attached. Tension bar weight can be adjusted by

removing springs or switching to a different type.
• Weight can also be adjusted by attaching weight-adjustment springs at two positions on the

feeding side, at left and right. Set the springs in both positions to the same level. Uneven levels
may bend the tension bars and affect print quality.

• Wear gloves when replacing or removing the springs. The shafts to which the springs are
attached are greased. Do not wipe off the grease on a shaft.

l Tension bar adjustment

1 To adjust tension bar weight, change the weight-adjustment springs.

2 Add or remove counterweights to make tension bars heavier or lighter.

• When adjusting the weight, change it gradually.
• Keep unused weight-adjustment springs in the box to avoid losing them.

2
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• For reference, this chart shows the combined effect of counterweights and weight-adjustment
springs. 

Weight with counterweights attached (each side)

No spring Top-mounted

No spring Bottom-mounted

Green spring Bottom-mounted

Blue spring Bottom-mounted

Green spring Top-mounted

Blue spring Top-mounted

Tension bar weight [N]
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Attaching weight-adjustment springs

1 Loosen the screw and remove the bracket holding the weight-adjustment shaft.

Screw

Weight-adjustment shaft bracket

2 Pull out the weight-adjustment shaft.

• Rotate the hole on the weight-adjustment shaft sideways, then raise the tension bar.

Weight-adjustment shaft

3 Remove the weight-adjustment spring currently attached.

• Otherwise, replace the current spring with a different one.

Weight-adjustment spring

4 Attach the weight-adjustment shaft.

• When attaching the weight-adjustment shaft, make sure the guide is facing the correct way.

Guide direction

2
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5 With the hole of the weight-adjustment shaft facing the side, insert the shaft and push the
bracket all the way in.

Hole

6 Tighten the screw.

Attaching counterweights for tension bar weight adjustment

• If the counterweights shown below are included (28 weights, 50 g each), they can be attached
as follows.

• Check the media tension and attach a suitable amount of weight.

• Consider media characteristics when deciding whether to attach counterweights.
• Up to 14 counterweights can be attached on each side, at left and right.
• Loosen the mounting screws to remove counterweights.

Mounting screw

Do not remove the weights originally attached.

Counterweights

• When you will attach or remove the last counterweight in the stack, be sure to sufficiently loosen
the mounting screws. If the screws are not sufficiently loose, the counterweight may catch on
the screws of the weights originally attached, preventing removal.
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Roll holder setting position
A label showing the roll holder setting position is placed on the leg stay. Use it as a reference to move the
roll holder, then secure using the knob screw.

Rol l  Holder
Set Posi t ion

Rol l  Holder
Set Posi t ion

Set the roll holder reference line within the area
indicated by the arrows as shown below.

Loading position
for paper core

Reference

Front

2
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Loading the Roll Media
Rolls of cloth media can be loaded on the printer with or without using tension bars. The media is detected
as you load it.

• When loading the media in the center, use the take-up extension cable.
• Adjust the head height to suit the intended use.

Using the tension bars
The media path when cloth media is loaded is shown in the following figure. 
Understanding the media path before loading will make loading easier.

• Confirm that parts that come into contact with the media path are clean. Clean this area if it is
dirty.

• Before loading media using tension bars, make sure the direct-connection unit is attached to the
feeding unit. If a torque limiter is attached, replace it with a direct-connection unit as described
in  "Replacing the direct-connection unit/torque limiter"(P. 56).

Media path

1 Close the front cover and press the [FUNC2 (MEDIA)] key.

• A screen is displayed for selecting use of tension bars.

2 Select how tension bars will be used, which is based on how the media is loaded.

• In this case, select the option for feeding only. 
(DC: direct-connection unit, TL: torque limiter, --: unit off)

• Press  to select feeding only, then press the [ENTER] key.

SELECT USE TENSION-BAR

FEEDING ONLY DC

OFF

• This screen is not displayed if the feeding unit is set to OFF in the options for roll unit
selection.
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3 Secure the feeding tension bar by setting it in the locked position.

Lock position

Tension bar

4 Attach reversing bars to suit the media you will load.

• To stabilize feeding-side tension, attach reversing bars at suitable positions for the media you will
load.

• Recommended positions are shown below. If the media is loose or vertically wrinkled with the
reversing bars in these positions, refer to  "Loading roll media without using tension
bars"(P. 76) to set the tension appropriate for the media.

(1) Loosen the knob screw on the outer surface of the reversing bar brackets on the left and right.
• You can now move the reversing bar bracket freely.

(2) While holding the knob screw, move the reversing bar bracket toward you.
• Move the bracket until it reaches the stopper.

Knob screws

Reversing bar bracket

(3) Insert and lower reversing bars.
• Fit the reversing bars into the bottom notch of the hole.
• Make sure the reversing bars are mounted in the correct positions. Mounting bars in the

wrong position will prevent you from securing them.

(4) Move the reversing bar bracket toward the machine and secure it.
• Do this for the reversing bar brackets on the left and right.

2
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5 Insert a roll bar through the roll.

• Insert a roll holder that fits the paper core and tighten the screws.

Media

Roll holder

Roll bar

• Be sure to insert the roll holder all the way in. Incorrect insertion may cause the paper
core to be gouged.

• Two types of roll holders are available. Choose one that matches the paper tube of the
media used. (See the following figure.)

Small roll holder
(1 to 1.5 inch)

Large roll holder
(2 to 3 inch)

6 Set the bar holder to the locked position.

Bar holder

• Press the bar holder all the way in and make sure it does not rotate.

7 Load media on the bar holder.

Media
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• When loading roll media, be careful to avoid dropping it on your feet. Heavy media may
cause injury.

• At least two people should load roll media. The weight of the roll media can injure your
back.

8 Slide the bar holder and tighten the screws.

Bar holder

9 Rotate the media by hand and confirm that it turns without problems.

10 Lower the feeding tension bar.

2
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11 Load the media in the machine.

Media path

(1) Load media, referring to the media path.
• Pass the media over the tension and reversing bars to ensure suitable tension.

• Pass the media over the smoothing roller and curved bar, then under the pressure roller
handle.

(2) Holding the handle with both hands, slide the locking sliders on the left and right inward, then
slowly lower the pressure roller.
• The media is now held in place.

• If you are not using the smoothing roller, refer to  "Removing the smoothing roller and
shifting coils"(P. 84), or if you are not using the curved bar, refer to  "Using the curved
bar to make sagging media taut"(P. 83).
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• Be careful when handling the pressure roller, which is heavy.

12 Press the [ENTER] key.

• The feeding tension bar is activated to detect and adjust media tension on the feeding side.
• After media detection on the feeding side, the media take-up diameter is detected.

• Load media so it is not loose.
If the media is loose, a feeding tension bar error may occur.

• Confirm that the rotation direction switch is set to the correct direction.
Media printed on the inner surface: Up (reverse)
Media printed on the outer surface: Down (forward)

13 Smooth out any wrinkles in the media and configure peeling settings.

• Press  to select ON or OFF, then press the [ENTER] key.

◎ON DC

○OFF

PEELING

•  "Loading media when using peeling"(P. 78)
•  "Loading media without using peeling"(P. 79)

• This screen is not displayed if the take-up unit is set to OFF in the options for roll unit
selection.

14 When a message indicates to load media in the take-up unit, press .

• The feeding belt moves, and media is fed toward the front of the machine.
• Feed media while manually rotating the peeling roller.

Peeling roller

15 When the media reaches the take-up unit, release  to stop feeding the media.

2
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16 Load the empty paper core in the take-up unit and adjust the take-up legs to stabilize them on
the floor.
• After mounting the paper core, set up the take-up legs on the floor.

Paper core

Take-up unit

17 Secure the media on the take-up unit.

(1) Secure the middle of the media with adhesive tape.
• If necessary, press  to feed the media.

(2) Secure the left and right sides the same way.
• Pull the left and right sides of the media evenly, making sure it is not loose or wrinkled, then

secure it with tape.

• Secure wide media in at least five positions with tape or the like. The more positions
secured, the more even the media tension will be.

• If the paper core is misaligned with the cloth as loaded, loosen the roll holder screw and
adjust to bring the core into position.

• From a low line of sight with the feeding roll visible, make sure both media edges are
aligned with both edges of the feeding roll.
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18 Press the take-up unit switch to take up the media a little, about one revolution, onto the paper
core.

Direction selector switch On/off button

(1) Take up the media by setting the take-up direction selector switch at left and then pressing the
on/off button at right to activate it.

(2) Once the media is taut, stop take-up by switching off the on/off button at right.
• The take-up unit should revolve at least once as you take up media.
• If not, press  again to feed the media and take it up with the take-up unit.

• If there is not enough media to wrap around the paper core, be sure to press  to feed
the media before taking it up with the take-up unit. 
Forcing take-up without enough media may damage the machine.

19 Press the [ENTER] key.

• After loading media, print a job and confirm that tension is applied to the media correctly. 
White or black streaks in printed images indicate that the tension is not suitable for the
media loaded. 
Reposition the reversing bar or adjust the weight of feeding tension bar. Keep checking
until these parts are correctly positioned.

2
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20 Set the take-up diameter.

• When the take-up diameter detection in the options is set to "AUTO" (  P. 109), the media take-
up diameter is automatically detected after the media is loaded.

(1) After the take-up diameter is automatically detected, a screen appears to confirm the detected

take-up diameter.

CHECK DIAMETER

DIA.DETECT

FEEDING UNIT

TAKE-UP UNIT

250mm

50mm

(2) Check the actual take-up diameter, and if there is no problem, press the [FUNC3] key (OK).
• If there is a difference between the displayed and the actual take-up diameters, press the [FUNC1]

key (No Good) and correct the take-up diameter.

INPUT DIAMETER

DIA.DETECT

FEEDING UNIT

TAKE-UP UNIT

250mm

50mm

(1) Enter the take-up diameter of the feeding unit.
• Press  to select the feeding unit, then press the [ENTER] key.
• Press  to enter the media outer diameter (diameter) of the feeding unit, then press

[ENTER] key.
(2) Enter the take-up diameter of the take-up unit.

• Press  to select the take-up unit, then press the [ENTER] key.
• Press  to enter the media outer diameter (diameter) of the take-up unit, then press

[ENTER] key.
(3) Press the [FUNC3] key (OK) when you have made the correction.

• When the take-up diameter detection in the options is set to "MANUAL" (  P. 109), enter the
take-up diameter using the procedure above.
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l When using media that does not stretch easily

• It is advisable not to use the smoothing roller with media that does not stretch easily. Remove
the smoothing roller before loading the media.  "Removing the smoothing roller and shifting
coils"(P. 84) 
Otherwise, you can load the media to follow a path that bypasses the smoothing roller.

Media path

Curved bar

Smoothing roller

Path to avoid smoothing roller (dotted lines)

2
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Adjusting the reversing bars
To print with suitable tension for the media, adjust the positions and quantity of reversing bars.

l Adjustment if media is too loose
Make the wrap angle larger. This will increase media tension.

l Adjustment if media is too taut
Make the wrap angle smaller. This will decrease media tension.

Loading roll media without using tension bars
Follow these instructions to load media without using tension bars. When setting media, read the following
notes carefully.

• When loading roll media without using tension bars, replace the direct-connection unit on the
feeding unit with an included torque limiter.  "Replacing the direct-connection unit/torque
limiter"(P. 56)

• Continuous printing without tension bars is limited to about 10 m. For continuous printing longer
than 10 m, use tension bars to load the media.

The media path when loading cloth media without tension bars is shown in the following figure.
Understanding the media path before loading will make loading easier.

Media path
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• Before loading cloth media, make sure the area around the feeding belt is clean. Clean this area
if it is dirty.

• When loading roll media without using tension bars, adjust media tension with reversing bars
and torque limiters.  "Adjusting the reversing bars"(P. 76)

1 Close the front cover and press the [FUNC2 (MEDIA)] key.

• A screen is displayed for selecting use of tension bars.

2 Select how tension bars will be used, which is based on how the media is loaded.

• In this case, select OFF. 
(DC: direct-connection unit, TL: torque limiter, --: unit off)

• Press  to select OFF, then press the [ENTER] key.

SELECT USE TENSION-BAR

FEEDING ONLY TL

OFF

• This screen is not displayed if the feeding unit is set to OFF in the options for roll unit
selection.

3 Load the media on the feeding side.

• Follow steps 3–9 in  "Using the tension bars"(P. 66).

4 Feed the media to the take-up side and load an empty paper core in the take-up unit.

• Follow steps 11–16 in  "Using the tension bars"(P. 66).

5 Secure the media to the paper core.

• Follow steps 17–19 in  "Using the tension bars"(P. 66).

6 Set the take-up diameter.

• Follow step 20 in  "Using the tension bars"(P. 66).

Setting the media edge guides

1 After loading media, move the media edge guides on the left and right sides until they touch
the edges of the media lightly.

Media edge guide
Media edge guide

2
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• Set the guides so that the media edges rise 5 to 10 mm.
• Be careful not to overtighten media end guide knob screws, which may bring the guides

into contact with the belt.

Loading media when using peeling

• When using peeling with the take-up unit, make sure a direct-connection unit is attached to the
take-up unit. If a torque limiter is attached, replace it with a direct-connection unit as described
in the following section.

 "Replacing the direct-connection unit/torque limiter"(P. 56)
• Interfering with the peeling sensor when loading media may cause an error to be displayed or

may activate the take-up unit.
• Using media that clings strongly to rubber tape may cause feeding problems. In this case, peel

off the rubber tape before use.

l Loading media in the take-up unit

1 Press the [FUNC2 (MEDIA)] key and load the media in the feeding unit.

• For details, refer to the following section. 
 "Using the tension bars"(P. 66)or  "Loading roll media without using tension bars"(P. 76)

2 Activate the peeling function.

• Press  to select ON, then press the [ENTER] key.

◎ON DC

○OFF

PEELING

• This screen is not displayed if the take-up unit is set to OFF in the options for roll unit
selection.
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Loading media without using peeling

• Take-up using a torque limiter may not be possible when using media that clings strongly, or if
the paper core on the take-up side is warped due to heavy media. In this case, we recommend
activating peeling and using a direct-connection unit for take-up.

• When using the take-up unit without peeling, replace the direct-connection unit attached to the
take-up unit with a torque limiter.  "Replacing the direct-connection unit/torque limiter"(P. 56)

l Loading media in the take-up unit

1 Press the [FUNC2 (MEDIA)] key and load the media in the feeding unit.

• For details, refer to the following section. 
 "Using the tension bars"(P. 66)or  "Loading roll media without using tension bars"(P. 76)

2 Deactivate the peeling function.

• Press  to select OFF, then press the [ENTER] key.

○ON TL

◎OFF

PEELING

• This screen is not displayed if the take-up unit is set to OFF in the options for roll unit
selection.

3 Secure the media on the take-up unit.

• For details, refer to steps 12 to 17 in  "Using the tension bars"(P. 66).

l Entering the remaining amount of media

1 Display the screen for entering the remaining amount of media.

50.0m

Enter the MEDIA REMAIN

MEDIA REMAIN

40°/50°

2 Press  to enter the amount of media remaining.

3 Press the [ENTER] key.

l Media width setting
Set the media width as follows.

2
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1 Press  to move the LED pointer to the right edge of the media.

• Press  to move the carriage and align the light from the built-in LED pointer with the right
edge of the media.

40°/50°

RIGHT EDGE POSITION

2 Press the [ENTER] key.

• Next, a screen is displayed for entering the position of the left edge of the media. This screen is
not displayed and the setting is finished if you select media width input mode in step 2.

40°/50°

LEFT EDGE POSITION

3 Press  to move the LED pointer to the left edge of the media.

• As in step 3, align the light from the LED pointer with the left edge of the media.

4 Press the [ENTER] key.

• If you are not using overprinting, be careful not to set the position outside of the media
area, which may result in printing off the media surface.

l Resetting media settings
Do the following before loading media again if you will change the print area setting or use different media.

1 In local mode, press the [SEL] key, then press [FUNC2 (MEDIA)].

2 Press the  keys to select how to reset the media, then press the [ENTER] key.

• The following two options are available for resetting media settings.

(1) Width only: Reset only the print area (width) setting.
(2) All: Reset all media detection information.

3 Press the [ENTER] key.

Adjusting pressure roller weight
Adjust the pressure roller weight if the media clings strongly and cannot be peeled off, or if it clings weakly
and lifts up.

l Adjustment if media clings strongly
Attach the included springs in the area outlined in red in the figure (at left and right).

• Springs for strong pressure roller adjustment: 2 pcs.
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• Springs for slight pressure roller adjustment: 2 pcs.

l Adjustment if media clings weakly
Attach the included weights in the area outlined in red in the figure (at left and right).

• Pressure roller ballast weights: 40 pcs. (20 for each side)

• Always attach the included grommet after loading weights.

Grommet

Pressure roller ballast weights

Adjusting the peeling sensor position
Depending on the type of media and the condition of the adhesive, media may not be peeled off correctly.
Check the positions of the peeling sensors and adjust them as needed.

1 Check the positions of the peeling sensors.

• Check where light from the peeling sensors strikes the reflectors on the right side of the machine.

Sensor (upper)

Sensor (lower)

Sensor (error)

2
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2 Reposition the sensors as needed.

• Referring to the figures, loosen the two screws on the peeling sensor section and reposition the
sensors.

Screw

Recommended sensor positions

l Adjustment if media clings strongly
Adjust the lower sensor upward to avoid false detection of sensor errors.

Media

Peeling roller

Belt

Adjust the lower sensor upward

l Adjustment if media clings weakly (especially with large-diameter rolls)
Adjust the upper sensor downward.

Media

Peeling roller

Belt

Adjust the upper sensor downward

• For consistent detection, adjust sensor positions so that the light shines within approx. 5 mm
from the edge of each reflector.
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Using the curved bar to make sagging media taut
Always use the curved bar to make sagging cloth media taut if gummed left and right media edges are quite
short compared to the center. (In this case, the center sags significantly when the media is spread out on the
floor).

Angular adjustment of the curved bar

Retaining screw
Curved part

Retaining screw

Flat part

• The position of the curved part of the bar (which determines the angle it forms) must be
adjusted to suit the condition of cloth media.

• With cloth media loaded, adjust so that the left and right edges of media sag only slightly by the
curved bar.

• Change the angle formed by the curved bar to suit the condition of the media.
(1) Flat part: Normally, this part is used.
(2) Curved part: Used for cloth media that sags in the center.

• When using the curved bar, load the media based on the center.

Height adjustment screw

Retaining screw

Tilt adjustment screw

(1) Height adjustment screw: Sets the curved bar one level higher if the bar does not eliminate
sagging in the center of the media.

(2) Tilt adjustment screw: Adjusts the angle of the curved bar according to the condition of the
media.

1 Remove the tilt adjustment screw on the side of the curved bar and adjust the bar angle.

(1) Remove the tilt adjustment screw and loosen the retaining screw.
(2) Rotate the curved bar to adjust the amount in contact with media.
(3) Secure the curved bar with the tilt adjustment and retaining screws.

2 Set the curved bar one level higher if the bar does not eliminate sagging in the center of the
media.

2
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l When the curved bar is not used

• If the curved bar will not be used, remove both tilt adjustment screws (at left and right) and
loosen the retaining screws (at left and right). Next, rotate the curved bar so that it no longer
touches the media, then retighten the screws.

Retaining screw
Tilt adjustment screw

• Do not remove the curved bar, even when it is not used. This may allow media surfaces to
interfere with each other when the pressure roller is lowered.

Removing the smoothing roller and shifting coils
The smoothing roller prevents wrinkles from forming when cloth media is applied to the feeding belt by the
pressure roller. Normally, cloth media is placed in the center. Even narrow cloth should always be placed in
the center of the feeding belt. 
However, in the following cases, you can reposition the center of the cloth by shifting smoothing roller coils.

• To reduce printing time by loading cloth toward the right side
• To extend the useful life of adhesive by loading cloth normally used at widths of 800 mm or less toward

the left or right edge

• Keep your hands and clothes away from the smoothing roller while it is in use. Getting caught in
the roller poses a risk of fractures or other injury.

• Wide cloth media with thin or frayed edges poses a risk of getting caught on the thumbscrews at
each end of the smoothing roller. 
Cut the edges of this media before loading it.

1 Remove the smoothing roller thumbscrew on the left side of the back of the machine, then
remove the smoothing roller.
• To remove, lift and slide left.

Retaining screw

• Tilt the end of the shaft up when removing. Otherwise, the smoothing roller may come off
and damage the machine.
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2 Loosen the knob screws on the left and right ends of the smoothing roller and shift the coils
as needed.

Knob screws

• See "Shifting Coils" for details on shifting coils.

3 Reinstall the smoothing roller.

l Shifting coils
You can reposition the central area of the coils as shown in the following figure. 
Smoothing coils are color-coded based on the direction of rotation.

White Gray

1 Remove knob screws, then remove enough coils from the left end to reposition the center as
desired.

2
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2 Slide coils left to fill up the empty space, tighten the knob screw, then remove the knob screw
on the right end.

3 Using the coils removed in step 1, add the coils to the shaft from the right end.

4 Tighten the knob screw.

The central area of the coils has now been repositioned.
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Registering the Media
Registration is required to use media that is not registered on the machine.

• To set print conditions for a single use, select "Temporary". The conditions set in "Temporary"
are cleared when the machine is restarted.

1 Perform a media reset to reconfigure the media.

(1) On the LOCAL mode screen, select [MEDIA].

DATA CLEARADJUST

LOCAL

MEDIA

(2) Select [Width only] as the media reset method.
Media
Media Reset

Width only
All

• Width only: Initializes origin information only.
• All: Initializes the media type and other settings.

2 Select [Unregistered].

Media selection
● PVC
○ Tarpaulin
○ Unregistered
○ Unregistered

1/2
1300 mm
1600 mm

○ Unregistered

3 Select the method for managing the media remaining amount.

• Select whether or not to manage the media remaining amount with the machine.

Media Registration
Media Remain Manage
Please Select.

ON
OFF

4 Enter the name to be displayed.

• If you do not register the name, press the [ENTER] key.

Media Name Change
Media 3
will be changed
(maximum 10 characters)

5 Select whether or not to register the set information.

do you optimize setting?
Execute

Do not
execute

2
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• You can change the settings later.  "Media Setting Menu"(P. 102)
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2.5 Test Printing
Print a test pattern to confirm that the ink prints correctly. Perform head cleaning if you observe any ejection
failures (e.g., nozzle clogging or deflection).  "Head Cleaning"(P. 91)

Head 1Head 1

Head 2Head 2

Head 1Head 1

Head 2Head 2

[For Sb420 ink]

Check beforehand

• Was the print head adjusted?  "Adjusting Print Head Height"(P. 51)
• Is media loaded?  "Loading the Media"(P. 55)

• Load media at least 500 mm wide. You cannot print the entire pattern if media less than 500
mm wide is used.

• Select [Maintenance] > [Nozzle Recovery] > [Test Print], then select "ON" to perform nozzle
recovery and test printing. 
Registration is required to perform nozzle recovery.  "Registering Nozzle Recovery"(P. 107)

2
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Changing the Layout Direction for Test Printing
You can change the layout direction for test printing.

1234

2

3

4

: Feed direction
(Feeds the medium and prints repeatedly in the longitudinal direction.)

: Scan direction
(Prints repeatedly in the horizontal direction.)

1 On the LOCAL mode screen, select [TEST PRINT/CLEANING] > [Test Print], then press the
[ENTER] key.
• The Test Print menu is displayed.

2 Select [Scan Dir.] or [Feed Dir.], then press the [ENTER] key.

• Test printing starts.

Good example Bad example

Nozzle Deflection Nozzle clogging

3 Check the print results.

Ejection Failures
Typical examples of ejection failures (e.g., nozzle clogging, deflection) are as shown below. In order to
prevent printing in such a state, check whether the ink has been properly ejected regularly before printing.

1
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Nozzle Deflection Nozzle clogging Ink drips

Mixed airMist
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2.6 Head Cleaning
The following head cleaning methods are available. Choose the method based on test results. Cleaning is
not possible when the [Ink Near End] or [Ink End] errors are displayed. Replace with new ink.  "Replacing
Ink"(P. 42)

Item Details

Soft If the print shows a bent line (Nozzle deflection)

Normal If the print shows a missing line (nozzle clogging)

Hard If soft cleaning and normal cleaning fail to resolve ejection failures (e.g., nozzle clogging
or deflection).

1 On the LOCAL mode screen, select [TEST PRINT/CLEANING] > [Cleaning], then press the
[ENTER] key.
• The Cleaning menu is displayed.

2 Select the cleaning type, then press the [ENTER] key.

3 Select the head to be cleaned, then press the [ENTER] key.

• Check the check box. Heads with checked check boxes will be cleaned.

4 Run another test print and check the print results.

• Repeat the cleaning and test printing process until the print results appear normal.

• Do the following if head cleaning fails to resolve the ejection failures (e.g., nozzle clogging
or deflection).

 "Cap Rubber Cleaning"(P. 118)
Print Head Nozzle Washing

 "Wiper Cleaning"(P. 120)

2
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2.7 Feed Correction
Changing the media may affect the feed amount due to various factors, including the weight and thickness of
the media and whether the take-up unit is used. Correct the drop position to suit the type of media used.
Image defects (e.g., dark or light streaks) will result if the feed is not properly corrected.

Check beforehand

• Is media loaded?  "Loading the Media"(P. 55)
• For roll media, is the rear roll media free of sagging?
• When using the take-up unit, is the media mounted on the paper core of the take-up unit?  "Loading

the Roll Media"(P. 66)

Feed Correction Procedure
Print a correction pattern, then enter the correction value. The value corrected here will also be updated on
the Media Setting menu.

• When using the take-up unit, load media on the take-up unit before correcting.
• Set the media aligning the center datum with the media setting position guide plate.  "Roll

holder setting position"(P. 65) 
Check and adjust around the center of the machine.

1 On the LOCAL mode screen, select [ADJUST].

width:1340mm

DATA CLEARADJUST

LOCAL

2 Select [Feed Comp.], then press the [ENTER] key.

• Correction pattern printing starts.

3 Check the print results.

• A correction value input screen appears.
• Adjust the bands so that the region between them is evenly colored.

Second band

First band

Good example Bad example

4 Enter the correction value, then press the [ENTER] key.

• "+" input: Increases the separation between bands.
• "-" input: Reduces the separation between bands.
• Increment the correction value by "30" to move the bands by approximately 0.1 mm.

5 Press the [ENTER] key.

• Print another correction pattern to check.
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Correcting the Media Feed During Printing
You can also correct the media feed amount in REMOTE mode or during printing.

1 Press [ADJUST] in REMOTE mode or during printing.

2 Enter the correction value, then press the [ENTER] key.

• Correction value: -9999 to 9999
• The value entered here will be updated immediately.

2
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2.8 Correcting the Drop Position
Changing the media and print head height and temperature changes around the print head will also alter the
drop positions. Correct the drop position to suit the type of media used. Image defects (e.g., overlaid lines or
blurred images) will result if the drop position is not properly corrected.

Check beforehand

• Was the print head adjusted?  "Adjusting Print Head Height"(P. 51)
• Is media loaded?  "Loading the Media"(P. 55)

• Load media at least 500 mm wide. You cannot print the entire pattern if media less than 500
mm wide is used.

Drop Position Correction Procedure
Print a correction pattern, then enter the correction value. The value corrected here will also be updated on
the Media Setting menu. This must be adjusted for each print resolution.

• Set the media aligning the center datum with the media setting position guide plate.  "Roll
holder setting position"(P. 65) 
Check and adjust around the center of the machine.

1 On the LOCAL mode screen, select [ADJUST].

width:1340mm

DATA CLEARADJUST

LOCAL

2 Select [Drop.PosCorrect], then press the [ENTER] key.

3 Select the resolution, then press the [ENTER] key.

• Select the resolution to be adjusted. When "All" is selected, correction patterns for all resolutions
will be printed.  "Media Setting Menu"(P. 102)

• The indicated resolutions are those in the scan direction.

4 Check the print results.

• A correction value input screen appears.
• Enter the position where the two upper and lower lines coincide.

In this case, the drop position correction value will be "+4.0".

Media feed direction
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5 Enter the correction value, then press the [ENTER] key.

• Correction value: -40 to 40

• If the lines do not coincide when the correction value is within the range -40 to 40, the
print head height may have been improperly adjusted. Adjust the print head height.

 "Adjusting Print Head Height"(P. 51)

6 Enter the correction value in the same way for pattern 2 and subsequent patterns.

2
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2.9 Preparing RIP data
The explanation here applies to MIMAKI RIP software (RasterLink).

• Prepare suitable image data for printing.

1 Launch RasterLink.

• Click the icon on the PC desktop.

2 Select the image data to print.

(1) Select [File] > [Open].
(2) Select the desired image data, then click [Open].

• If multiple printers are registered, select Tx330-1800B in "Printer Name".

3 Select the image data imported.

• The image data is added in the tab for Tx330-1800B selected in "Printer Name".
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4 Edit the image.

• Specify the following settings by clicking the function icons shown on the right-hand side of the
screen: 

 (General Print): Specifies settings like enlargement/reduction and rotation. 
 (Quality): Selects a color profile for the media and ink set loaded in this machine.

• For more information, refer to the RasterLink reference guide. https://mimaki.com/
download/software.html

5 Print image data.

•  "Starting Printing"(P. 99)

(1) Click  (Execution) from the function icons on the right-hand side of the screen.
(2) Select "Immediate Print" or "RIP and Print", then click [Start].

• Media width must be reacquired after replacing media.
(1) Select the tab for Tx330-1800B in the main window.

(2) Click  (Update the printer status) in the Printer tab.

2

https://mimaki.com/download/software.html
https://mimaki.com/download/software.html
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2.10 Printing
Check beforehand

• Was the print head adjusted?  "Adjusting Print Head Height"(P. 51)
• Is media loaded?  "Loading the Media"(P. 55)
• For roll media, is the rear roll media free of sagging?
• When using the take-up unit, was the media mounted on the paper core of the take-up unit? 

"Loading the Roll Media"(P. 66)

• Condensation may form on the print head nozzle surface depending on the ambient
temperature and humidity. The formation of condensation may cause ejection failures (e.g.,
nozzle clogging or deflection). Perform head cleaning if any ejection failures (e.g., nozzle
clogging or deflection) occur during printing.  "Head Cleaning"(P. 91)

Changing the origin
The print start position can be altered. Use the LED pointer to set the origin.

• Print origin default value
– Feed (longitudinal, X') direction: Approx. 75 mm to rear from platen front edge
– Scan (lateral, Y') direction: 15 mm from right edge of media

Platen front
edge

Approx. 75 mm (X')

15 mm (Y')Belt

1 On the LOCAL mode screen, press .

• The Origin Setup screen appears.

2 Press  to move the origin to the desired position.

• The carriage moves left and right and feeds the medium.

• The machine cannot feed media backward.

3 Press the [ENTER] key.

• The origin is updated.
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Starting Printing

1 Send the RIP data from the PC.

•  "Preparing RIP data"(P. 96)

• If the message "Attention20A Driver version" appears, install the latest Mimaki driver.
https://mimaki.com/download/inkjet.html

2 Start printing.

• Printing starts once RIP data is received.

REMORT

NRS 0.0m

600x600    16p / Bi / Hi / Vd

[Resolution]

[Number of passes]

[Scan direction] (Uni: unidirectional, Bi: bidirectional)

[Scan speed] (Std: standard, Hi: high speed)

[Dot type]
VD: Variable dot
ND: Normal dot

Length of medium printed

[Nozzle Recovery]

: A part of nozzles can be recovered
: All nozzles can be recovered

: Not registered or the print mode
where nozzles cannot be recovered

NRS
NRS
OFF

• Print speeds may differ for the same image data, depending on the width of the medium
loaded, print origin position, and resolution.

• If an error occurs, the machine switches to LOCAL mode once printing is completed.
Further printing is not possible.

Pausing Printing

1 Press [LOCAL] while printing is in progress.

• Printing is paused.
• If data is being sent from a PC, data transmission is paused at the PC.

2 Press [REMOTE].

• Printing resumes.

• No other functions can be used when printing is paused.

2

https://mimaki.com/download/inkjet.html
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Stopping Printing (Data Clear)

1 On the LOCAL mode screen, select [DATA CLEAR].

width:1340mm

DATA CLEARADJUST

LOCAL

2 Press the [ENTER] key to clear the received data.

• The receive buffer is cleared.
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3.1 Media Setting Menu
When you use the machine for the first time, the Select Use Media screen is displayed.  "Registering the
Media"(P. 87) The media Information and correction value can be saved in advance for specific media.
The user can select to prioritize the settings on the machine or the settings on the PC. Setting individual
menus to "Host" prioritizes PC settings. To prioritize settings for this machine, select a setting other than
"Host".

• For more information on how to specify RIP software, refer to the RIP software operating
manual.

l Menu List
Item Setting Details

*1 *2

Feed Comp. -9999 to 0 to
9999

- Corrects the media feed amount. Print a pattern and enter the
correction amount.  "Feed Correction"(P. 92)

Drop.PosCorrect - - Corrects the drop position for bi-directional printing. 
"Correcting the Drop Position"(P. 94)

(Resolution) * - Select the resolution to be corrected.
When "All" is selected, correction patterns will be printed for all
resolutions.

* The available resolutions vary according to the model.

(Correction
Value)

-40.0 to 0 to
40.0

- Check the pattern and enter correction values.

Auto-correction - - The auto-correction function (DAS: Dot Adjustment System)
detects a correction pattern with the sensor and automatically
corrects the drop position.
When "All" is selected, "Feed Comp." and "Drop.PosCorrect"
are corrected.

• Check to confirm that the media does not lift up.
• Load white and clean media.
• Media such as synthetic paper, tarpaulin, or cloth media

may not be detected.
• Do not send RIP data from the PC during pattern printing.
• If automatic correction is unsuccessful, correct the position

manually. [MENU] > [Media Setting] > [Feed Comp.] or
[Drop.PosCorrect]

All -

Feed Comp. - -

Drop.PosCorrect - -

(Resolution) * - Select the resolution to be corrected.
When "All" is selected, correction patterns will be printed for all
resolutions, and the drop position is corrected automatically.

* The available resolutions vary according to the model.

External Heater ON/OFF Turns the external heater on or off.

MAPS4* - - MAPS: Mimaki Advanced Pass System
This function disperses the boundaries between passes to
make feed streaks between passes less visible.
Altering MAPS may alter the color. This function may be less
effective with certain types of images.

* The MAPS version will vary according to the model.
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Item Setting Details

*1 *2

MAPS* AUTO/
MANUAL

- This should normally be set to "AUTO". When set to
"MANUAL", the following items are displayed:

Speed 50 to 100 % - Reducing speed will make streaks less visible. However,
printing will be slower.

Smoothing
Level (Color)

0 to 100 % - Increasing smoothing makes streaks less visible. Make
separate settings for color and spot color (white).

Media Information - - Enter the media information.

Media Remain - - The remaining roll media amount can be displayed and printed
out in REMOTE mode. The print length will be displayed when
leaf media is in use.

Media
Remain
Manage

ON/OFF - • ON: An input screen appears once the media width is
detected.  Press  to set the media length. 
Press the [FUNC3] key on the "Origin Setup" screen to
print the date and remaining media amount.

• OFF: The remaining media amount is not displayed.

Length 0 to 500 m - Enter the roll media length.

Stop Printing ON/OFF Setting to "ON" stops printing when the Media Remain value
reaches 0.

Detail Setting - - This is used to set various functions.

Feed Speed Host/10 to
100 to 200 %

100 Sets the media feed speed.
• Depending on print conditions, the speed may not vary for

certain settings.
• Setting to 100 % or more reduces the time required to

complete printing but may affect print quality due to
insufficient drying time.

Belt Comp. ON/OFF Set to reduce uneven feeding and improve print quality.

Belt Wash

Belt Wash ON/OFF Sets whether belt washing is performed automatically.

Belt Feed
Speed

Normal/Low Sets the feed speed for purposes other than printing, such as
feeding activated by the  key, or checking the feed.

Counter Limit

Adhesive OFF, 1 to
30000 m

Sets the approximate replacement time.

Absorption
Roller

OFF, 1 to
30000 m

Sets the approximate replacement time.

Drying Feed OFF/100 to
1000 mm

OFF Sets the distance for media feeding after printing.

Media Name
Change

- - You can change the name of a setting type. The name can
include alphanumeric characters or symbols.

Delete MediaInfo - - Delete the set media information.

*1. The default settings are shown underlined.
*2. Settings applied if no settings can be made in the RIP software (host) or if this machine is prioritized.

3
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3.2 Maintenance Menu
This menu is used for maintenance actions. It also lets the user perform nozzle recovery if nozzle clogging
persists even after cleaning and nozzle washing.

l Menu List
Item Setting*1 Details

Station Maint. - This moves the carriage to allow station and print head
maintenance.Carriage Out -

Move To Platen
Right End

- Cleans around the station, including caps and wipers, and changes
the head height.

 "Cap Rubber Cleaning"(P. 118)
 "Wiper Cleaning"(P. 120)
 "Adjusting Print Head Height"(P. 51)

Move To Maint.
Space

- Cleans around the print head.
 "Carriage Underside Cleaning"(P. 119)
 "DAS (Automatic Correction Function) Sensor

Cleaning"(P. 123)

Nozzle Wash 1 to 99 min Washes the print head nozzle surface with maintenance liquid to
resolve ejection failures (e.g., nozzle clogging or deflection). Print
Head Nozzle Washing

Pump Tube
Cleaning

- Washes the suction pump tube (below the cap).  "Ink Discharge
Channel Cleaning"(P. 124)

Custody Wash 1 to 99 min Perform this step if the machine will not be used for extended
periods. The function washes nozzles and drainage channels to
maintain the machine in optimal condition.  "When this Printer is
Left Unused for a Long Time"(P. 150)

Replace Wiper - Use this function when replacing the wiper. Replacing the wiper
resets the wiper usage counter.  "Wiper Replacement"(P. 154)

Cap Replacement - Use this function when replacing the cap. Replacing the cap resets
the cap usage time stored in the machine.  "Cap
Replacement"(P. 157)

Test Printing - Print a test pattern to confirm that the ink prints correctly. Perform
head cleaning if you observe any ejection failures (e.g., nozzle
clogging or deflection).  "Test Printing"(P. 89)

Cleaning - Several head cleaning methods are available. Choose the head
cleaning method based on test print results.  "Head
Cleaning"(P. 91)

Nozzle Recovery - Allows other nozzles to be used for printing if maintenance actions
like nozzle washing fail to resolve print defects (e.g., nozzle
clogging, deflection).

Print - Prints a pattern to check nozzle condition and register the nozzle.
 "Registering Nozzle Recovery"(P. 107)

Entry - Registers the nozzle without printing a pattern.

Reset - Initializes the details set.

Test Printing ON/OFF Sets whether to perform nozzle recovery before test printing.

Nozzle Check -  "Nozzle Check"(P. 108)

Printing Check ON/OFF Performs nozzle clogging detection before printing starts.
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Item Setting*1 Details

Check Interval - Sets the nozzle clogging detection timing.

Length 0.1 to 30.0 to
100.0 m

Performs nozzle clogging detection after the length set is reached
and before the next print starts.

File 1 to 30 to
1,000 files

Performs nozzle clogging detection after the preset number of files
has been printed and before the next print starts.

Continuation
Print

Stop/
Continuous

Select whether to stop or continue printing if "Nozzle clogging" is
detected.

Action Off/1 to 10 to
100

Performs nozzle recovery (cleaning followed by nozzle checking) if
"nozzle clogging" is detected.

Cleaning Soft/Normal/
Hard

Sets the cleaning type.

Retry Count 0 to 3 times Performs nozzle recovery (cleaning followed by nozzle checking)
for the specified number of times.

Auto Nozzle
Recovery

ON/OFF Performs nozzle recovery automatically if "nozzle clogging" is
detected. See below if you wish to perform nozzle recovery
manually.

 "Registering Nozzle Recovery"(P. 107)

Judgment Condition OFF / 1 to 64
nozzles

Set the number of nozzles to be detected as clogged before
"nozzle clogging" is detected. Up to 16 nozzles per row can be set.
The next print will not start if "nozzle clogging" is detected during
continuous printing.

Auto Maint. - Sets various maintenance actions to be performed automatically.
Set the interval between individual maintenance actions.

• If the warning message "Replace Wasteinktank" appears, the
automatic maintenance function is disabled.  "Waste Ink
Tank Replacement"(P. 163)

Refresh 0.5/1.0 h Sets the refresh interval (when a small amount of ink is ejected
from the print head nozzles).

Pump Tube
Cleaning

OFF/48h/1 to
168 h

Sets the interval for washing the suction pump tube (below the
cap).

Cleaning Interval 1 to 48 h Sets print head cleaning intervals. This will help prevent nozzle
clogging.

Type Normal/Soft/
Hard

Sets the cleaning type for head cleaning.

Print Maint. - Sets the maintenance to be performed automatically midway
during printing.

Auto Cleaning - Sets the conditions to perform head cleaning after the preset
number of files are printed.

Setup File/Length/
Time/OFF

Sets the conditions to perform head cleaning.

Interval - Sets head cleaning intervals.

(File) 1 to 1,000 Cleaning starts when the set number of files is exceeded.

(Length) 1 to 1,000.0
m

Cleaning starts when the set print length is exceeded.

(Time) 10 to 240 min Cleaning starts when the set print time is exceeded.

Type Normal/Soft/
Hard

Sets the cleaning type for head cleaning.

3
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Item Setting*1 Details

Cleaning Check ON/OFF Sets whether nozzle checking is performed after head cleaning is
completed.

Interval Wiping OFF/3 to 255
min

Wiping starts when the set print time is exceeded.

Refresh Weak/
Standard/
Strong

Select the refresh (flushing) time during printing.

Waste Ink Tank - Resets or corrects the waste ink tank usage count.  "Waste Ink
Tank Replacement"(P. 163)

Reset Waste Ink
Tank Volume

- Resets the waste ink tank usage count.  "Replacing the lower-
left waste ink tank"(P. 163)

Adjust Waste Ink
Volume

- Corrects the waste ink tank usage count.  "When "Check Waste
Ink Tank" message appears"(P. 163)

Tank Capacity - Displays the waste ink tank capacity.

Air PG - Expels any air in the ink paths.
• Use this if Ink End is still displayed after ink replacement.

Belt Maintenance -

Belt Washing Unit - Moves the washing unit to the maintenance position and cleans
the washing brush and inside the tray.  "Washing Unit
Maintenance"(P. 131)

Belt Adhesive -  "Reapplying Adhesive"(P. 136)

Peeling Off
Adhesive

- Performs the steps for peeling off the adhesive.

Applying
Adhesive

- Performs the steps for applying adhesive.

Belt Cleaning - Cleans the feeding belt.  "Cleaning the Feeding Belt"(P. 147)

Replace Water -  "Washing Water Replacement"(P. 130)

Drain - Drains washing water from the washing unit.

Supply - Supplies washing water to the washing unit.

Cleaning Wash
Tray

- Cleans the washing tray and brush.

Counter Reset -  "Resetting the Counter"(P. 149)

Adhesive - Initializes the counter for notification.

Absorption
Roller

- Initializes the counter for notification.

*1. The default settings are shown underlined.
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Registering Nozzle Recovery
Allows other nozzles to be used for printing if maintenance actions like nozzle washing fail to resolve ejection
failures (e.g., nozzle clogging or deflection).

• Nozzle recovery can be specified for up to 20 nozzles per row. The time taken for printing
remains unchanged even when nozzle recovery is set.

• Load media at least 500 mm wide. You cannot print the entire pattern if media less than 500
mm wide is used.

1 Position the media.

2 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

3 Select [Nozzle Recovery] > [Print], then press the [ENTER] key.

• Print a nozzle recovery pattern.
• The Select Entry Nozzle screen appears once printing is complete.

100 0102030405060708090

H1-D   K

H1-C   Y

H1-B   C

H1-A   M

1

101

201

301

401

510 0

No.203

H1-A   M

Nozzle row number

Head number
Approx. 300 mm

Ap
pr

ox
. 3

30
 m

m

4 Select the "head number and nozzle row" for nozzle recovery, then press the [ENTER] key.

SELECT ENTRY NOZZLE

Head1-A >

>Head1-B

>Head1-C

>Head1-D

>><<

>Head1-E

Head number Nozzle row number

5 Enter the "nozzle number" for nozzle recovery, then press the [ENTER] key.

• Select the entry number before entering the nozzle number.
• Nozzle recovery is set.

Head2-D

No.1

No.2

16

128

No.3 184

No.4 OFF

No.5 OFF

>><<

Entry number 1 to 20 Nozzle number

3
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6 Press the [ENTER] key once entry is complete.

• Select [Maintenance] > [Nozzle Recovery] > [Test Print], then select "ON" to perform
nozzle recovery and test printing.  "Test Printing"(P. 89)

Nozzle Check
This is used to check for nozzle clogging before printing starts. Sets whether to perform maintenance
functions automatically if nozzle clogging is detected.

If ≥ the set value

[Printing Check]

ON

The nozzles are not checked.
OFF

Performs nozzle recovery automatically.

Nozzle check (nozzle clogging detection)

Continue Printing

If less than the set value

[Judgment Condition] setting for nozzle clogging
detection

[Nozzle Recovery] (cleaning followed by nozzle
checking)

* Repeated by [Retry Count] cycles.

[Judgment Condition] setting for nozzle clogging
detection

Stop Printing

If ≥ the set value

[Auto Nozzle Recovery]

ON
OFF

If less than the set value
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3.3 Function Setting Menu
This is used to set various operations to ensure optimal machine performance.

l Menu List
Item Setting*1 Details

Logical Seek Host/OFF/ON Sets the range of carriage movement.
• ON: Print data area

Unidirectional printing Bi-directional printing

Print data
Carriage movement

Option Roll Unit Select - Selects the roll unit used.

Feeding unit ON/OFF Set to "OFF" if the feeding unit is not used.

Feed tension bar ON/OFF Displayed when the feeding unit is on. Set to "OFF" if the
feeding tension bar is not used.

Take-up Unit ON/OFF Set to "OFF" if the take-up unit is not used.

Peeling ON/OFF Displayed when the take-up unit is on. Set to "OFF" if peeling is
not performed.

Feeding/take-up
switch

Continuous/
Temporary

Set the operation to assign to the feeding/take-up switch.
• Continuous: Operation continues until the switch is pressed

again.
• Temporary: Operates only while the switch is pressed.

When the direct-connection unit is is attached, feeding/take-up
only continues as long as the switch is pressed, regardless of
the continuous/temporary setting.

Take-up diameter
detection

AUTO/
MANUAL

Sets the method for detecting the media outer diameter for the
take-up unit and feeding unit.

Drying Time - Sets the time for ink to dry.

Scan Host/0.0 to
9.9 sec

Sets the stop time of the carriage after each scan.
• The MIMAKI RIP software (RasterLink) indicates this as

"Pause Time per Scan".

Print End Host/0 to 120
min

Sets the stop time after printing. The next data is printed once
the set time has elapsed.

• The Mimaki RIP software (RasterLink) does not allow the
user to specify Print End. If the machine is set to "HOST",
the time will be "0".

Power Setting - Sets the times to turn the power on and off automatically.

Auto Power-off 5 to 15 to 60
min

Sets the time until the power is automatically turned off.

Auto Power-on - Sets the time to automatically turn on the power.

Setup ON/OFF Sets whether to turn on or off the power.

Time 0:00 to 23:59 Sets the time to turn on the power.

3
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Item Setting*1 Details

Day Monday to
Sunday

Sets whether to turn on or off the power on each day of the
week.

Nozzle Check ON/OFF Automatically executes the nozzle check function when the
machine is started with auto power-on. Performs nozzle
recovery (cleaning followed by nozzle checking) if "nozzle
clogging" is detected.

Cleaning Soft/Normal/
Hard

Sets the cleaning type.

Retry Count 0 to 3 times Performs nozzle recovery (cleaning followed by nozzle
checking) for the specified number of times.

Top Blower ON/OFF Sets the blowing fan operation during printing.

Strength AUTO/Low/
High

Sets the blowing fan wind strength.

WhiteSpace Setting - Sets the offset value from the media left and right standard
margins (15 mm).

• The Mimaki RIP software (RasterLink) does not allow the
user to specify margins. If the machine is set to "Host", the
offset value will be "0 mm" for the left and right margins.

Margin -

Margin/Left Host/-10 to 85
mmMargin/Right

View Feed ON/OFF Sets whether or not to feed the media forward to view the print
results—for example, during test printing.

Auto Remote ON/OFF Sets whether to automatically switch to REMOTE mode and
start printing if data is received locally.

*1. The default settings are shown underlined.
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3.4 Environment Setting Menu
This is used to set various operations to ensure optimal machine performance.

l Menu List
Item Setting*1 Details

LANGUAGE English / 日本
語 / Deutsch /
Português /
Español /
Italiano /
Korean

Sets the display language.

Time Set -20 to 0 to +4
h

Sets the current time and date. (With respect to JST)
• This can be set within the range of -20 to +4 hours.

Key Buzzer ON/OFF Sets an audible tone when keys are pressed.
• Audible signals indicating errors, warnings, and operation end

cannot be muted, even if "OFF" is selected for this setting.

Unit Setting - Set the display units.

Temp. °C/°F Sets the display unit for temperature (Celsius/Fahrenheit).

Length mm/inch Sets the display units for length and area.
• Some items are displayed in "mm" even if "inch" is selected.

Network - Sets the network address. The machine must be restarted to enable
this setting.

Check IP
Address

- Displays the machine's current IP address.
• It may take some time to determine the IP address. If the IP

address cannot be determined, the display will indicate "0.0.0.0".

Check MAC
Address

- Displays the machine's current MAC address.

DHCP ON/OFF Select "ON" to use the IP address assigned by the DHCP server.

AutoIP ON/OFF Select "ON" to use the IP address set by the AutoIP protocol. Note
that DHCP takes priority if DHCP is set to "ON".

Ip Address - Sets the IP address used by the machine.
• This can be set when both [DHCP] and [AutoIP] are disabled.

Default Gateway - Sets the default gateway used by the machine.
• This can be set when both [DHCP] and [AutoIP] are disabled.

DNS Address - Sets the DNS server address used by the machine.
• This can be set when both [DHCP] and [AutoIP] are disabled.

Sub Net Mask - Sets the subnet mask used by the machine.
• This can be set when both [DHCP] and [AutoIP] are disabled.

Remote Control - An application (MRA: Mimaki Remote Access) is required to use the
remote control function. MRA is a remote access tool installed on a
computer or smartphone that allows viewing of product information
and panel operation from a remote location away from the machine
(within the same network segment).

Setup Enable/
Disable

Enable/disable remote control.

3
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Item Setting*1 Details

PIN code 0000 to 9999 Enter the same PIN code as MRA. The PIN code is used for
authentication between the machine and MRA.

• When the machine is set to "0000", MRA can access the
machine with any PIN code.

KeyLife 5 to 30 to 120
min

Sets the time interval before disconnecting the machine and MRA if
no operations are performed using MRA.

Machine Reset - Initializes the details set.

*1. The default settings are shown underlined.
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3.5 Machine Status Menu
This is used to check machine information.

l Menu List
Item Details

Usage WIPING The number of wiping cycles is displayed.
• To reset the number of wiping cycles, press the [FUNC2] key while the

level is displayed.

Print Length Displays the total length printed.

Print Area Displays the total area printed.

Use Time Displays the total time the power has been turned on.

Waste Ink
Tank

Displays the approximate level of waste ink in the waste ink tank as a
percentage.
To reset waste ink levels, press the [FUNC1] key while the level is displayed.

Capping Use
Days

Displays the number of days since the cap was replaced.

Adhesive Displays the feed distance since adhesive was applied.

Absorption
Roller

Displays the distance representing use of the absorption roller.

Maintenan
ce History

Maintenance Displays a record of maintenance function execution (up to 10).
• Cleaning  P. 91, Pump Tube Cleaning  P. 124, Nozzle Washing

Print Head Nozzle Washing

Replace
Wiper

Displays a record of wiper replacement (up to 5).  P. 154

Ink
replacement

Displays a record of ink pack replacement for each ink slot (up to 5).
"Replacing Ink"(P. 42)

• Slot 1 to 8

Cap
Replacement

Displays a head cap replacement history.  "Cap Replacement"(P. 157)

Version Displays the machine firmware and other versions.

Error History Displays the error and warning history.
• These are listed in chronological order. Use the keys to cycle through

occurrence time/date and error/warning information.

List This is used to print machine information.

3
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Chapter 4 Maintenance

This chapter
To ensure years of precise performance, maintain the machine periodically based on
frequency of use. 
Read the maintenance precautions thoroughly before maintaining this product.
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4.1 Maintenance Precautions
• This machine includes parts that must be replaced periodically. We therefore recommend taking

out a maintenance contract. Carry out maintenance periodically and replace consumable items
to prevent quality defects and accidents.

• Clean periodically. Debris and dust will accumulate on electrical components when the machine
is used for extended periods. There is a risk of failure, electric shock, or fire due to current
leakage.

• Do not clean by blowing—e.g., avoid using air blowers. Doing so may lead to failure, electric
shock, or fire involving the machine if airborne debris or dust gets inside electrical components.
Wipe using a soft cloth soaked in diluted neutral detergent and thoroughly wrung out. A vacuum
cleaner may also be used for cleaning.

• Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

• Never touch the print head nozzle surface. Do not allow water or alcohol to come into contact
with the print nozzle surface. This will increase the risk of machine failure or ejection failures
(e.g., nozzle clogging or deflection).

• Do not use cotton swabs to clean around the head or carriage. Fibers from cotton swabs may
adhere to the head nozzle surface and lead to ejection failures (e.g., nozzle clogging or
deflection).

• Do not splash ink or maintenance liquid on the covers. Exposure to splashing ink or
maintenance liquid may damage or deform the cover.

• Do not use benzine, thinner, or any chemical agent containing abrasives. Use of these
chemicals may result in damage to or deformation of parts.

• Do not use organic solvents such as acetone and IPA. Doing so may damage the machine.
• Do not move the carriage by hand. To move the carriage, use the carriage out function on the

menu.



Chapter 4 Maintenance

117

4.2 Maintenance Methods

Maintenance Items and Timing

Timing Item

Every day after work Clean around the wiper.  "Wiper Cleaning"(P. 120)

Replace the washing water.  "Washing Water Replacement"(P. 130)

Every three days, at the
start of the work

Shake the ink.  "Ink Maintenance"(P. 118)

At the end of the week's
work

Clean the cap rubber.  "Cap Rubber Cleaning"(P. 118)

Clean the underside of the carriage.  "Carriage Underside Cleaning"(P. 119)

Check the waste ink levels in the waste ink tank.  "When "Check Waste Ink
Tank" message appears"(P. 163)

Clean the peeling roller.  "Peeling Roller Cleaning"(P. 127)

Clean the belt correction unit.  "Belt Correction Unit Cleaning"(P. 127)

Clean the washing unit.  "Washing Unit Maintenance"(P. 131)  "Resetting
the Counter"(P. 149)

Clean the feeding belt.  "Cleaning the Feeding Belt"(P. 147)

Clean the peeling sensor.  "Cleaning the Peeling Sensor"(P. 148)

At the end of two
weeks' work

Clean the blowing fan filter.  "Blowing Fan Filter Replacement"(P. 161)

Every month Clean the NCU.  "NCU Cleaning"(P. 122)

Clean the DAS sensor.  "DAS (Automatic Correction Function) Sensor
Cleaning"(P. 123)

Clean the jam sensor detecting plate.  "Jam Sensor Detecting Plate
Cleaning"(P. 126)

Clean the cover (exterior).  "Cover (Exterior) Cleaning"(P. 150)

When not used for
more than a week

Clean the cap and wash the ink discharge channels. After cleaning, store without
turning off the main power supply.  "When this Printer is Left Unused for a
Long Time"(P. 150)

When the adhesive
strength of the feeding
belt has decreased

Reapply the adhesive.  "Reapplying Adhesive"(P. 136)  "Cleaning the
Washing Tray and Brush"(P. 146)  "Resetting the Counter"(P. 149)

Items Required for Maintenance
To order replacement consumable items, contact your local dealer or our service office. For more information
on consumable items, refer to our website (https://mimaki.com/supply/inkjet.html).

• Do not store consumable items in locations where children may enter.

4
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Ink Maintenance
If ink constituents are sedimented, the ink density may become uneven. We recommend shaking the ink
periodically to keep printing consistent.
Once every three days.

• Shake taking care that the ink eco-cases do not become detached from the ink supply unit.
Ink may leak out if the ink eco-cases become detached.

1 Shake the ink eco-cases slowly approximately 10 times.

• Shake the ink eco-cases back and forth while holding the top.

• Be sure to shake the ink eco-case back and forth by holding its top. Ink may leak out if the
top is not held and the ink eco-cases become detached.

Cap Rubber Cleaning
The cap prevents the print head nozzle surface from drying out. Continuing to use a dirty cap may affect ink
take-up and lead to ejection failures (such as nozzle clogging or deflection).

• Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the feeding belt.

3 Open the maintenance cover on the right side.
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4 Clean the cap rubber.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

• Clean the areas indicated in red in the diagram (the entire interior and exterior of the cap rubber,
the tabs, and the mesh retainers).

5 Close the maintenance cover, then press the [ENTER] key.

Carriage Underside Cleaning
The underside of the carriage becomes coated with ink wiped off by the wiper. Continuing to use the dirty
carriage underside will rub dried ink and attached dust on to the media, resulting in contaminated prints.
The print head uses an extremely delicate mechanism. Take great care when handling it.

• Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

• The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

4
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4 Clean around the print head.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

Clean the print head sides and all around the nozzle plate using a cleaning stick.

Never touch the
nozzles

Clean using a cleaning stick or soft cloth.

• Never touch the print head nozzles (areas indicated in blue in the diagram).

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

Wiper Cleaning
The wiper wipes off ink adhering to the print head nozzle surface. Continuing to use with a dirty wiper will
cause dried ink and attached dust to rub against the head nozzle surface, and lead to ejection failures (e.g.,
nozzle clogging or deflection).

• Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the feeding belt.

3 Open the maintenance cover on the right side.
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4 Remove the wiper.

• Hold the lug at the rear of the wiper bracket, then pull out the wiper.

Lug

5 Clean the wiper and bracket.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

Wiper

Bracket

• Replace dirty or warped wipers with new ones. Wiper Replacement

6 Clean the wiper slider.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

• If there is a lot of ink in the pad case, use absorbent paper or the like to absorb it.

4
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7 Reattach the wiper at the original position.

Projection

8 Once cleaning is complete, close the cover, then press the [ENTER] key.

NCU Cleaning
The NCU uses a sensor to monitor the ink droplets ejected from the print head nozzles. Continuing to use
the dirty NCU may prevent the nozzle check function from operating correctly.

• Be careful to avoid leaving fragments from the cleaning stick behind when cleaning. These
fragments will increase the risk of ejection failures (e.g., nozzle clogging or deflection).

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the feeding belt.

3 Open the maintenance cover on the right side.
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4 Clean the NCU.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

• Insert the cleaning stick as far as the line shown in the illustration.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

DAS (Automatic Correction Function) Sensor Cleaning
The DAS sensor is located on the carriage underside. If dust or debris accumulates on the sensor, DAS
(  P. 102) may not function.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

• The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

4
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4 Clean the DAS sensor.

• Wipe clean using cotton swabs or a soft cloth.

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and
thoroughly wrung out.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

Ink Discharge Channel Cleaning
Clean the ink discharge channel regularly to prevent clogging of the ink discharge channel below the cap.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Pump tube cleaning], then press the [ENTER] key.

• The cap is filled with maintenance liquid.

• Close the cover. The cap cannot be filled with maintenance liquid while the cover is open.
This is also true if the maintenance liquid cartridge is empty.

3 Open the maintenance cover on the right side.

• Check to confirm that approximately half a capful of maintenance liquid remains.
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• If not, use a syringe to draw up some maintenance liquid and drip in approximately half a
capful.

• Check to confirm that there is approximately half a capful of maintenance liquid inside.

• If not, use a syringe to draw up some maintenance liquid and drip in approximately half a
capful.

4 Close the maintenance cover, then press the [ENTER] key.

• Pump tube (ink discharge channel below the cap) washing starts.

4
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Jam Sensor Detecting Plate Cleaning
Continuing to use the dirty carriage underside will rub dried ink and attached dust on to the media, resulting
in contaminated prints.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Maint. Space], then press the [ENTER] key.

• The carriage moves to the maintenance space.

3 Open the maintenance cover on the left side.

4 Clean the jam sensor detecting plate.

• Clean the jam sensor detecting plate underside at the left and right sides of the carriage.
• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe

off the maintenance liquid. Make sure none remains.

5 Once cleaning is complete, close the cover, then press the [ENTER] key.
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Peeling Roller Cleaning

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

Belt Correction Unit Cleaning
Adhesive applied to the feeding belt may adhere to the rubber gripper on the belt correction unit. Any
adhesive on the rubber gripper may cause the belt correction unit to slip and affect printing quality. Regularly
clean (about once a week) the rubber gripper of the belt correction unit and the 30 mm portion at the edge of
the feeding belt (all around the left side, as viewed from the front).

1 Clean the edge of the feeding belt.

• Wipe the 30 mm portion of the feeding belt's left edge with a waste cloth soaked in alcohol.

2 Feed the belt by specifying the count in [Maintenance] > [Belt Maintenance] > [Belt Cleaning].
4
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3 Repeat steps 1 and 2 to clean the entire length of the belt.

4 Turn off the main power supply.

• Turn off the main power supply and unplug the power cable before carrying out any
further maintenance.

5 Raise the pressure roller.

• Holding the sections labeled GRIP with both hands, pull toward you.

G
R
IP

G
R
IP

6 Lock the pressure roller.

• Holding the sections labeled GRIP with both hands, slide the two sections outward.
• Make sure the left and right sides are securely locked.

G
R
IP

G
R
IP

7 Remove the maintenance cover.



Chapter 4 Maintenance

129

8 Clean the rubber gripper.

• Using a cloth soaked in alcohol, wipe the rubber gripper above and below the feeding belt.

Rubber gripper

Feeding belt

Rubber gripper

9 Attach the maintenance cover.

Blowing Fan Filter Cleaning
Wash the blowing fan filter in water if it is dirty.

l Recommended cleaning guide

• Check the filter for dirt every two weeks, and wash.
• Replace the filter every three months.  "Blowing Fan Filter Replacement"(P. 161)

• Turn off the main power and unplug the power cable before replacement.

1 Remove the fan filter cover.

• Push the fan filter cover claw outward, and pull the cover to the front.

Fan filter cover

Claw
4
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2 Remove the filter.

Blowing fan filter

3 Wash the filter.

• Dry the filter after washing.

4 Attach the dry filter together with the fan filter cover.

• Push in the fan filter cover until the tab clicks.

Washing Water Replacement
If the feeding belt is still dirty after belt washing, replace the washing water. Replace the washing water every
day if the belt is not cleaned under flowing water.

1 In local mode, press [FUNC1 (MENU)] >  > [ENTER] key.

• The Maintenance menu is displayed.

2 Press  to select [Belt Maintenance], then press the [ENTER] key.

3 Press  to select "REPLACE WATER," then press the [ENTER] key.

• The Washing Water Replacement Setup screen appears.

4 Press  to select "DRAIN," then press the [ENTER] key.

5 Press the [ENTER] key.

• A message is displayed indicating that the washing unit is moving and requesting you to wait.
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6 When a message requests you to open the drainage valve because water will be drained,
place a bucket or the like under the valve and open the valve.

Drainage valve

7 Press the [ENTER] key.

• Draining begins, as indicated by a message requesting you to wait.

8 After a message indicates that draining is finished, close the valve.

9 Press the [ENTER] key.

• A message now asks if you wish to supply washing water.

10 Press the [ENTER] key.

• A message indicates that water supply will start and asks you to close the drainage valve.

11 Close the valve and press the [ENTER] key.

12 Press the [ENTER] key once "Start to supply water" appears on the display.

• Water supply starts, and "Supplying water. Please wait" appears on the display.

• Adjust the amount of water with the cock of the water supply valve if the amount of water
is too much or too little.

13 Press the [ENTER] key once "Completed to supply water" appears on the display.

14 Press the [ENTER] key.

• "Reset the wash unit. Please wait" appears on the display.
• When the washing unit returns to the standby position, the Washing Water Replacement Setup

screen appears.

Washing Unit Maintenance

Cleaning the Belt Washing Unit
Move the belt washing unit to the maintenance position and clean the washing brush and inside the tray.

1 In local mode, press [FUNC1 (MENU)] >  > [ENTER] key.

• The Maintenance menu is displayed.

2 Press  to select [Belt Maintenance], then press the [ENTER] key.

4
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3 Press  to select [BELT WASH UNIT], then press the [ENTER] key.

4 Press the [ENTER] key.

5 Raise the pressure roller and remove the media.

• Remove any loaded media.

6 Press the [ENTER] key.

• Instructions for moving the washing unit are displayed.

7 Press the [ENTER] key.

• The washing unit is moved to the rear of the machine.

8 Remove the feeding unit.

• Remove any loaded media.
• Remove the feeding unit from the machine and move it out of the way.

• If a screen in local mode is displayed again because you accidentally held down the END
key or opened a cover after removing the feeding unit, repeat the initial steps as follows.
(1) Turn off the main power supply.
(2) Attach the feeding unit.
(3) Turn on the main power supply.
(4) Start again from step 1.

9 Press the [ENTER] key.

• The water supply valve control screen is displayed.

10 Clean the washing unit.

• To allow water to flow into the washing tray, press the [ENTER] key. The water supply
valve is opened and water is supplied to the washing tray.

• To stop the water, press the [ENTER] key again. The water supply valve is closed.

• Before releasing water from the water supply valve, make sure the drain hose is not
clogged. Running water with the drain hose clogged may cause water to overflow the
washing tray.

11 When cleaning is finished, press the [END/POWER] key.

• A screen is displayed to confirm that this process is complete.
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12 Attach the feeding unit.

• Reattach the feeding unit that was removed.

• Be sure to install the feeding unit while this screen is displayed.

Remove the feeding unit

from the machine [ENT]

BELT WASH UNIT

13 Raise the tension bar manually and press the [ENTER] key.

• If the feeding unit is attached incorrectly or the tension bar was not raised, the screen for
attaching the feeding unit is displayed again.

14 Press the ON/OFF button on the feeding unit.

15 Press the [ENTER] key.

• If the feeding unit does not rotate, the screen for attaching the feeding unit is displayed again.

16 Press the [ENTER] key.

• The washing unit is returned to the original position.

17 Press the [ENTER] key.

• A screen appears indicating that maintenance is finished.

18 Press the [ENTER] key.

Absorption Roller Cleaning
Dirt accumulates on the absorption roller when belt washing is used. To maintain good printing quality, clean
the absorption roller.

• Setting a general time to be notified of absorption roller cleaning will enable you to work without
worrying about the timing of this cleaning.

• To prevent used cleaning water from getting the floor dirty, spread out a waste cloth or the like
on the floor in advance.

• Before cleaning, put on rubber gloves.

Absorption Roller

Wringing roller

4
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1 In local mode, press [FUNC1 (MENU)] >  > [ENTER] key.

• The Maintenance menu is displayed.

2 Press  to select [Belt Maintenance], then press the [ENTER] key.

3 Press  to select [BELT WASH UNIT], then press the [ENTER] key.

4 Press the [ENTER] key.

5 Raise the pressure roller and remove the media.

• Remove any loaded media.

6 Press the [ENTER] key.

• Instructions for moving the washing unit are displayed.

7 Press the [ENTER] key.

• The washing unit is moved to the rear of the machine.

8 Remove the knob screws and rotate the left and right absorption roller brackets.

• The absorption roller is in the middle at the rear of the unit.

Knob screws

Absorption roller bracket

Absorption Roller

9 Remove the absorption roller from the machine.

• At least two people should remove the absorption roller.
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10 Rinse and then remove water from the absorption roller.

(1) Remove the screws at each end with a screwdriver, then remove one sleeve at a time for
cleaning.

(2) Clean the roller by rinsing it under tap water or the like.
• Do not wring out the sponge.

(3) After cleaning by rinsing, wrap the sleeve in a waste cloth such as a Bemcot cloth to absorb
the water.
• Do not wring out the sponge.

(4) Dry well before reassembly.

• If it is still dirty, replace the absorption roller (SP-01021) with a new one.

11 Reinstall the absorption roller.

• If a warning message appears, reset the counter.  "Resetting the Counter"(P. 149)

• Center the absorption roller to avoid gaps, then secure it.

4
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12 When cleaning is finished, press the [END/POWER] key.

• A screen is displayed to confirm that this process is complete.

13 Attach the feeding unit.

• Reattach the feeding unit that was removed.

• Be sure to install the feeding unit while this screen is displayed.

Remove the feeding unit

from the machine [ENT]

BELT WASH UNIT

14 Raise the tension bar manually and press the [ENTER] key.

• If the feeding unit is attached incorrectly or the tension bar was not raised, the screen for
attaching the feeding unit is displayed again.

15 Press the ON/OFF button on the feeding unit.

16 Press the [ENTER] key.

• If the feeding unit does not rotate, the screen for attaching the feeding unit is displayed again.

17 Press the [ENTER] key.

• The washing unit is returned to the original position.

18 Press the [ENTER] key.

• A screen appears indicating that maintenance is finished.

19 Press the [ENTER] key.

Reapplying Adhesive
If the adhesive strength is decreased by ink, loose threads, dust, or the like, the adhesive must be reapplied.

• When to reapply adhesive
It is time to reapply adhesive when printed media lifts up after emerging from the front cover.
Promptly reapply belt adhesive when a warning message advises to reapply it.

• Genuine Mimaki adhesive is solvent-based. When applying adhesive, always wear a protective
mask designed for working with organic solvents, as well as safety glasses and gloves.

• A ventilation system must be available when reapplying adhesive in a poorly ventilated area or
sealed room. When using adhesive, comply with the Ordinance on Prevention of Organic
Solvent Poisoning.

• Additionally, ensure that adhesive is reapplied under the supervision of someone who has
completed a technical training course for those in charge where organic solvents are used, or
someone appointed to supervise organic solvent work.
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• The adhesive is not the cause if the media sags even before use and lifts up or sags after being
applied to the feeding belt (with the pressure roller). Also note that this kind of media cannot be
used.

Peeling Off Adhesive
The following items are required in order to peel off adhesive.

l Items required
• Doctor, gloves

l Items to prepare
• Waste cloth
• Kerosene or light oil (approx. 500 cc)
• Ethanol (approx. 200 cc)
• Metal plate or oil-resistant plastic plate, shaped like a tray

• For convenience, consider transferring the kerosene (or light oil) and ethanol into containers
with a small mouth.

1 Open the maintenance cover on the left side.

2 Remove end covers 1 and 2.

End cover 1 End cover 2

3 In local mode, press [FUNC1 (MENU)] >  > [ENTER] key.

• The Maintenance menu is displayed.

4 Press  to select [Belt Maintenance], then press the [ENTER] key.

4
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5 Press  to select "BELT ADHESIVE," then press the [ENTER] key.

6 Press  to select "Peeling off adhesive," then press the [ENTER] key.

7 After a message requests you to remove the media, make sure no media is on the feeding
belt, then press the [ENTER] key.

8 When instructions indicate to raise the pressure roller, raise the pressure roller on the back of
the machine, then press the [ENTER] key.
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9 After a message requests you to set the doctor, attach the doctor on the front of the machine.

• Attach the doctor leaving a gap between it and the belt.

(1) Loosen the doctor adjustment plates (at each end), move the point of attachment to the top,
then tighten loosely.

Doctor
adjustment

plate

(2) Loosen the doctor guide blocks (at each end) enough to allow the doctor to move up and
down under its own weight.

Guide block

(3) Attach the doctor and secure it with screws.

Doctor

(4) Adjust the doctor adjustment plate height to around the level where the doctor blade touches
the feeding belt, then secure it in place.

Doctor adjustment plate

4
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10 Press  to set the feed speed, then press the [ENTER] key.

• Setting value: 5 to 60 [mm/s]

• 20 mm/s is recommended.

11 Place a waste cloth soaked in kerosene along the inside of the doctor on the feeding belt.

12 Press the [ENTER] key.

• The feeding belt now moves.

• To pause the feeding belt, press 
（ 1） the [FUNC2 (PAUSE)] key. 
(2) Press  to select [Belt Maintenance], then press the [ENTER] key.

• To change the feed speed, adjust by pressing [FUNC1 (SPEED UP)] / [FUNC3 (SPEED
DOWN)].

13 Dribble some kerosene or light oil on the back of the waste cloth.

• Allow the kerosene/light oil to soak into the adhesive on the surface of the belt well.

• When removing adhesive, dribbling too much kerosene/light oil may cause it to leak from
the end of the doctor and drip onto the feeding belt and into the washing water holder.

• Accidentally mixing kerosene/light oil with washing water may weaken the adhesive if you
are printing while washing the belt.

• Adhesive that suddenly weakens after reapplication may indicate that kerosene/light oil
has been mixed into the washing water.

• After peeling off and reapplying adhesive, always check the washing tray to make sure no
kerosene/light oil is mixed with the washing water. 
If you discover that they are mixed together, clean the washing tray and cleaning brush by
selecting "REPLACE WATER→CLEANING WASH TRAY" in the maintenance menu. 
"Cleaning the Washing Tray and Brush"(P. 146) Then replace the water in the washing
water tank with fresh water.
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14 To remove any adhesive that has turned into a gel due to the kerosene/light oil, press the
edge of the plate against the feeding belt at an outer position.

No sharp edges (to avoid damaging the belt)

15 Wipe off as much kerosene/light oil as possible from the belt surface with a waste cloth.

16 Clean the surface of the belt by wiping off any remaining oil with a waste cloth soaked in
ethanol.

17 Press [END/POWER] key > [ENTER] key to stop the feeding belt.

18 After a message about resetting the adhesive counter is displayed, press the [ENTER] key.

• The adhesive counter is reset.

19 Remove the doctor and wipe off any remaining adhesive or debris with kerosene/light oil and
a waste cloth.

Applying Adhesive
The following items are required in order to apply adhesive.

l Items required
• Doctor, gloves
• Vinyl tape (3 cm wide)
• Adhesive (Polixresin SX 1L, sold separately)

• Genuine Mimaki adhesive is solvent-based. 
When applying adhesive, always wear a protective mask designed for working with organic
solvents, as well as safety glasses and gloves.

• A ventilation system must be available when reapplying adhesive in a poorly ventilated area or
sealed room.

• When using adhesive, comply with the Ordinance on Prevention of Organic Solvent Poisoning. 
Additionally, ensure that adhesive is reapplied under the supervision of someone who has
completed a technical training course for those in charge where organic solvents are used, or
someone appointed to supervise organic solvent work.

• Open flames are strictly prohibited when reapplying adhesives. Always turn off all nearby
equipment, such as heaters. Also, be sure to ensure sufficient ventilation.

4
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• When using a commercial adhesive, be sure to check the compatibility of the solvents it
contains with the material that the belt is made of. In this case, contact your distributor or a
sales office.

• Be careful to avoid getting adhesive on the contact area of the belt correction unit (on the right
in the front of the machine) and near the 6 mm dia. hole. Doing so may prevent normal
operation of the machine.

• To the extent possible, avoid applying excessive adhesive, as this may cause feeding problems.
• Adhesive should generally be reapplied once every two weeks. (Timing varies depending on

usage and type of media.)

1 In local mode, press [FUNC1 (MENU)] >  > [ENTER] key.

• The Maintenance menu is displayed.

2 Press  to select [Belt Maintenance], then press the [ENTER] key.

3 Press  to select "BELT ADHESIVE," then press the [ENTER] key.

• The belt adhesive setting screen appears.

4 Press  to select "Applying Adhesive," then press the [ENTER] key.

5 After a message requests you to remove the media, make sure no media is on the feeding
belt, then press the [ENTER] key.

6 When instructions indicate to raise the pressure roller, raise the pressure roller on the back of
the machine, then press the [ENTER] key.

7 Cover the edges of the feeding belt with vinyl tape.

• Tape must be applied around the entire left and right edges of the feeding belt.
• If necessary, have two people do this, or repeat the process for the other edge after one

edge is finished.

8 Press the [ENTER] key twice.

• The feeding belt is activated and stops after one revolution. To pause the feeding belt, press the
[FUNC2 (PAUSE)] key.

• To change the feed speed, adjust by pressing [FUNC1 (SPEED UP)] / [FUNC3 (SPEED DOWN)].

9 Press the [ENTER] key.

• If tape was applied incorrectly, select [END/POWER]. After this, repeat step 8.
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10 After a message requests you to set the doctor, attach the doctor on the front of the machine.

• Attach the doctor without any gap between it and the belt.

(1) Loosen the doctor adjustment plates (at each end), move the point of attachment to the top,
then tighten loosely.

Doctor
adjustment

plate

(2) Loosen the doctor guide blocks (at each end) enough to allow the doctor to move up and
down under its own weight.

Guide block

(3) Attach the doctor and secure it with screws.

Doctor

(4) Adjust the doctor adjustment plate height to around the level where the doctor blade touches
the feeding belt, then secure it in place.

Doctor adjustment plate

4
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11 Press  to set the feed speed, then press the [ENTER] key.

• Recommended value: 15 m/s

12 Dribble 150 to 200 cc of adhesive evenly near the edge of the doctor.

13 Press the [ENTER] key.

• The feeding belt now moves.

• When using adhesive that is highly viscous, increase the belt speed.
• To change the feed speed, adjust by pressing [FUNC1 (SPEED UP)] / [FUNC3 (SPEED

DOWN)].
• To pause the feeding belt, press the [FUNC2 (PAUSE)] key. To resume moving the

feeding belt, press the [FUNC2 (START)] key.

• Add more adhesive to areas on the doctor where little adhesive remains.
• Apply adhesive across the entire belt surface.
• Use up all of the adhesive.
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• After the level of adhesive no longer decreases, gradually increase the height of the
doctor and apply a thicker coat.

• Do not lower the doctor after raising it, which will result in uneven adhesive.

14 Remove the doctor and wipe off any remaining adhesive or debris with kerosene/light oil and
a waste cloth.

15 Remove the tape around the feeding belt.

• When removing tape, peel it off toward the rear of the machine. This will allow the
adhesive to separate from the tape more easily.

16 To set a drying time, press the [ENTER] key.

• If you set a drying time, the feeding belt will automatically stop after the time elapses.
• The adhesive counter is reset.

17 Press  to set the drying time (in hours), then press the [ENTER] key.

18 Press  to set the drying time (in minutes), then press the [ENTER] key.

• The drying time countdown is activated.
• To stop it, press the [END/POWER] key.

19 After the adhesive on the feeding belt is dry, press [END/POWER] key > [ENTER] key to stop
the feeding belt.

4



Chapter 4 Maintenance

146

20 After a message about resetting the adhesive counter is displayed, press the [ENTER] key.

• The adhesive counter is reset.

• If, after drying, the adhesive is too strong, wipe the belt surface with a wet waste cloth to
prepare it for use. Using the belt this way may cause the media to stick to it and not come
off.

Cleaning the Washing Tray and Brush
If kerosene/light oil gets into the washing water when you reapply adhesive, clean the washing tray and
cleaning brush with a neutral detergent. Then replace the water in the washing water tank with fresh water.

l Items required
• Neutral detergent

• When cleaning, be sure to wear safety glasses and gloves.

1 In local mode, press [FUNC1 (MENU)] >  > [ENTER] key.

• The Maintenance menu is displayed.

2 Press  to select [Belt Maintenance], then press the [ENTER] key.

3 Press  to select "REPLACE WATER," then press the [ENTER] key.

• The Washing Water Replacement Setup screen appears.

4 Press  to select "CLEANING WASH TRAY," then press the [ENTER] key.

5 Press the [ENTER] key.

• The washing unit is moved to the rear of the machine.

6 When a message indicates that tray cleaning will start and the brush will be rotated, add
neutral detergent to the washing tray and press the [ENTER] key.
• The brush rotates, stirring the detergent.

• The cleaning brush rotates automatically. Be careful to avoid getting your hands or
clothing caught in it.

7 Clean the washing tray and brush.

• To stop the brush, press the [FUNC2 (PAUSE)] key.
• To resume moving the brush, press the [FUNC2 (START)] key.

• To allow water to flow into the washing tray, press the [ENTER] key. The water supply
valve is opened and water is supplied to the washing tray.

• To stop the water, press the [ENTER] key again. The water supply valve is closed.

8 When cleaning is finished, press the [END/POWER] key.

• A screen is displayed to confirm that this process is complete.

9 Press the [ENTER] key.

• A message now asks if you wish to drain washing water.
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10 Press the [ENTER] key and select "DRAIN WATER."

• Display changes to the menu for draining the washing water.

• If you have not used neutral detergent and do not need to drain the washing water, press
the [END] key to finish tray cleaning.

11 When a message requests you to open the drainage valve because water will be drained,
place a bucket or the like under the valve and open the valve.

Drainage valve

12 Press the [ENTER] key.

• Draining begins, as indicated by a message requesting you to wait.

13 After a message indicates that draining is finished, close the valve.

14 Press the [ENTER] key.

• A message now asks if you wish to supply washing water.

15 Press the [ENTER] key.

• A message indicates that water supply will start and asks you to close the drainage valve.

16 Close the valve and press the [ENTER] key.

17 Press the [ENTER] key once "Start to supply water" appears on the display.

• Water supply starts, and "Supplying water. Please wait" appears on the display.

• Adjust the amount of water with the cock of the water supply valve if the amount of water
is too much or too little.

18 Press the [ENTER] key once "Completed to supply water" appears on the display.

19 Press the [ENTER] key.

• "Reset the wash unit. Please wait" appears on the display.
• When the washing unit returns to the standby position, the Washing Water Replacement Setup

screen appears.

Cleaning the Feeding Belt
Clean the feeding belt as follows.

4
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• Before cleaning, be sure to remove any media on the feeding belt.

1 In local mode, press [FUNC1 (MENU)] >  > [ENTER] key.

• The Maintenance menu is displayed.

2 Press  to select [Belt Maintenance], then press the [ENTER] key.

3 Press  to select [BELT CLEANING], then press the [ENTER] key.

• The belt cleaning setting screen appears.

4 After a message requests you to remove the media, make sure no media is on the feeding
belt, then press the [ENTER] key.

5 When instructions indicate to raise the pressure roller, raise the pressure roller on the back of
the machine, then press the [ENTER] key.

6 Press  to set the number of cleaning cycles, then press the [ENTER] key.

• Setting value: 1 to 99 times
• Belt cleaning begins, and the number of cycles displayed is updated each time the belt goes

around.

• To stop cleaning, press the [END/POWER] key, then press the [ENTER] key.

7 After a message indicates that the process is complete, press the [ENTER] key.

• The Maintenance menu is displayed.

Cleaning the Peeling Sensor
To prevent peeling sensor malfunction caused by soiling, clean the peeling sensors regularly (about once a
week).

• The peeling sensors may be soiled by ink mist from printing or steam from drying media.

Also perform cleaning if any of the following occur.
• Media is not peeled off, and an alarm beeps.
• An alarm beeps even when media is not taken up on the belt.

1 Use a cotton swab soaked in maintenance liquid to wipe the reflectors.
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2 Dry the reflectors wiped in step 1 with a dry cotton swab.

3 Wipe the three light-emitting surfaces of the peeling sensors with a cotton swab soaked in
maintenance liquid.

4 Dry the lenses wiped in step 3 with a dry cotton swab.

Resetting the Counter
Initialize counters for adhesive and the absorption roller as follows.

1 In local mode, press [FUNC1 (MENU)] >  > [ENTER] key.

• The Maintenance menu is displayed.

2 Press  to select [Belt Maintenance], then press the [ENTER] key.

3 Press  to select "COUNTER RESET," then press the [ENTER] key.

• The counter reset setting screen appears.

4 Press  to select "Adhesive" or "Absorb Roller," then press the [ENTER] key.

• The counter is reset, and the maintenance menu is displayed.

4
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Cover (Exterior) Cleaning

• Be careful to prevent liquids from getting inside the machine. Otherwise there is a risk of failure,
electric shock, or fire.

• For heavy soiling, wipe using a soft cloth soaked in diluted neutral detergent and thoroughly
wrung out.

When this Printer is Left Unused for a Long Time
Clean as follows if the product is not used for one week or longer:

Check beforehand

Is [Near End] or [Ink End] displayed?
• Maintenance liquid and ink is aspirated during the washing operation. Washing is not possible if an

error occurs during this process. Replace with new ink.

• Do not turn off the main power supply. Turning off the main power supply will disable the
automatic maintenance function (including nozzle clogging prevention function and ink
discharge channel cleaning function). This increases the risk of ejection failures (such as nozzle
clogging or deflection).

• Do not leave the media on the belt. This may leave irregularities or ripples in the media.

• If Check Waste Ink is displayed, dispose of ink in the waste ink tank on the right of the machine.
 "Waste Ink Tank Replacement"(P. 163)

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Custody Wash], then press the [ENTER] key.

• The carriage moves over the feeding belt.
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3 Open the maintenance cover on the right side.

4 Clean the cap rubber.

•  "Cap Rubber Cleaning"(P. 118)

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

• The cap is filled with maintenance liquid.

• Close the cover. The cap cannot be filled with maintenance liquid while the cover is open.
This is also true if the maintenance liquid cartridge is empty.

6 Open the maintenance cover on the right side.

• Check to confirm that the cap is filled with maintenance liquid.

• If not, use a syringe to draw up some maintenance liquid and fill until it almost overflows
from the cap.

7 Close the maintenance covers.

8 Set the exposure time, then press the [ENTER] key.

• Cleaning is performed automatically once print nozzle washing has ended.
• The cap is filled with maintenance liquid.

9 Open the maintenance cover on the right side.

• Check to confirm that there is approximately half a capful of maintenance liquid inside.

4
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• If not, use a syringe to draw up some maintenance liquid and drip in approximately half a
capful.

10 Close the maintenance cover, then press the [ENTER] key.

• Pump tube (ink discharge channel below the cap) washing starts.
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4.3 Replacement of Consumable Item
To order replacement consumable items, contact your local dealer or our service office. For more information
on consumable items, refer to our website (https://mimaki.com/supply/inkjet.html).

• Do not store consumable items in locations where children may enter.

• When disposing of consumable items, contact an industrial waste disposal operator or dispose
of the product in accordance with the local laws and regulations.

Consumable Item Replacement Timing

Timing Item

When dirty  "Replacing the Absorber Around the Station"(P. 159)
 "Wiper Replacement"(P. 154)
 "Blowing Fan Filter Replacement"(P. 161)

When ejection failures cannot be
remedied

 "Cap Replacement"(P. 157)
 "Wiper Replacement"(P. 154)

When damaged  "Wiper Replacement"(P. 154)
 "Cap Replacement"(P. 157)

When replacing ink  "Ink Supply Unit Ink Absorber Replacement"(P. 162)

When "Replace Wiper" appears on
the display

 "Wiper Replacement"(P. 154)

When "Check Waste Ink Tank"
appears on the display

 "Waste Ink Tank Replacement"(P. 163)

Once a year  "Wiper Cleaner Replacement"(P. 155)

4
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Wiper Replacement
The machine maintains a count of the number of wiping cycles. The "Replace Wiper" message appears
when a preset count is reached. Replace dirty or warped wipers with new ones.

1 "Replace Wiper" appears on the display.

2 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

3 Select [Station Maint.] > [Replace Wiper], then press the [ENTER] key.

• The carriage moves over the feeding belt.

4 Open the maintenance cover on the right side.

5 Remove the wiper.

• Hold the lug at the rear of the wiper bracket, then pull out the wiper.

Lug
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6 Clean the wiper slider.

• Wipe off any ink and dust adhering using a cleaning stick moistened with maintenance liquid. Wipe
off the maintenance liquid. Make sure none remains.

7 Mount a new wiper.

Projection

8 Once replacement is complete, close the cover, then press the [ENTER] key.

• The wiper usage count is reset.

Wiper Cleaner Replacement
Replace with a new wiper cleaner (SPC-0243) once a year.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the feeding belt.

4
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3 Open the maintenance cover on the right side.

4 Remove the fitting.

• Hold the lugs on the fitting, then pull off.
• Take care to avoid losing the rubber seal.

2

1

1

5 Remove the wiper cleaner.

• Slide forward to remove.

2

1
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6 Mount a new wiper cleaner.

• Slide to the rear to attach it.

2

1

7 Reattach the fitting.

• Improper attachment may result in leaking maintenance solution.

8 Once replacement is complete, close the cover, then press the [ENTER] key.

Cap Replacement
If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after cleaning, replace with a
new cap.

• Be sure to replace the cap if you observe any scratches or other damage on the rim.

• When using Sb or TP ink for extended periods, the cap surface is susceptible to drying out,
which can lead to path clogging. If this occurs, either replace the cap or remove and wash it.

• We recommend replacing the cap every six to twelve months. 
(TP ink: every six months, other ink: every twelve months)

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

4
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2 Select [Station Maint.] > [Replace Cap], then press the [ENTER] key.

• The carriage moves over the feeding belt.

3 Open the maintenance cover on the right side.

4 Remove the cap.

• Squeeze the lugs on either side of the cap and pull off.

5 [When using Sb ink and TP ink] Rinse the cap with the mesh side facing downward in a
container filled with maintenance liquid. Remove, then wipe clean the resin part thoroughly.

6 Apply maintenance liquid.

• Use a syringe to apply two or three drops of maintenance liquid to the hole at the front.
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7 Mount a new cap or a cap that has been washed.

• Position with the slot at the front and push in until it clicks.

8 Once replacement is complete, close the cover, then press the [ENTER] key.

Replacing the Absorber Around the Station
If the cap absorber or maintenance liquid absorber is very dirty or if ink drips on to the media, replace with a
new cap absorber.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Carriage Out] > [Move To Platen Right End], then press the [ENTER]
key.
• The carriage moves over the feeding belt.

3 Open the maintenance cover on the right side.

4



Chapter 4 Maintenance

160

4 Remove the two screws, then remove the cap cover.

• Slide to the rear to detach the tabs at the front.

Cap absorber

5 Remove the cap absorber.

• Avoid ink dripping when removing the cap absorbers.

6 Mount a new cap absorber.

• Insert the tabs on the plate into the slits in the cap absorber.

• Check to confirm that the cap absorber does not become detached.

7 Remove the maintenance liquid absorber.

Slider block

8 Wipe away any maintenance liquid from around the slider block.

9 Mount a new maintenance liquid absorber.

• Push firmly on to the protrusion.

10 Check to confirm that the absorber is not lifting or curved.
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11 Insert the two screws to secure the cap cover in place.

12 Once replacement is complete, close the cover, then press the [ENTER] key.

Blowing Fan Filter Replacement
Replace the blowing fan filter if it is dirty.

If sublimation transfer ink is used
• Replace the filter every three months.

• Turn off the main power and unplug the power cable before replacement.

1 Remove the fan filter cover.

• Push the fan filter cover claw outward, and pull the cover to the front.

Fan filter cover

Tab

2 Remove the filter.

Blowing fan filter

3 Mount a new filter and the fan filter cover.

• Push in the fan filter cover until the tab clicks.

4
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Ink Supply Unit Ink Absorber Replacement
We recommend replacing the ink absorber each time you replace the ink pack, to prevent dirt building up on
the pedestal of the ink supply unit.

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

1 Push down the lever on the pedestal, and remove the ink Eco-case.

2 Remove the ink absorber, and replace with a new one.

3 Set an eco-case on the base.
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Waste Ink Tank Replacement
The ink used in printing and head cleaning is stored in the waste ink tanks on the right and left sides of the
machine.

• For a 2-liter tank, the preset level is 80 % (1.6 L).
• Continuing to use the product without disposing of the waste ink may result in waste ink

overflowing from the waste ink tank. Visually check ink levels in the waste ink tank about once a
week.

• Pay close attention to ventilation and be sure to wear safety glasses, gloves, and a mask when
handling ink, maintenance liquid, waste ink, or other solutions used with the machine. Leaking
ink may adhere to the skin or get into the eyes or mouth.

When "Check Waste Ink Tank" message appears

1 The "Check Waste Ink Tank" message appears on the display.

 
Check Waste Ink tank
Level: xx %

2 Check the waste ink levels in the waste ink tank.

• If you note any discrepancies from actual levels, proceed to the next step.
• If there is no discrepancy, replace (dispose of) the waste ink tank referring to  "Replacing the

lower-left waste ink tank"(P. 163).

3 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

4 Select [Waste Ink Tank], then press the [ENTER] key.

5 Select [Adjust Waste Ink Volume], then press the [ENTER] key.

6 Press  to adjust the level.

7 Press the [ENTER] key once adjustment is complete.

Replacing the lower-left waste ink tank

l Lower-right waste ink tank replacement

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Waste Ink Tank], then press the [ENTER] key.

3 Select [Reset Waste Ink Volume], then press the [ENTER] key.

4
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4 Hold the handle on the waste ink tank and slide out.

5 Attach the cap to the removed waste ink tank, and use tape to prevent leakage of waste ink.

• When disposing of ink, maintenance liquid or other liquid used with the product, or
containers or non-woven fabric contaminated with ink or other liquid, contact an industrial
waste disposal operator or dispose of the product in accordance with the local laws and
regulations.
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5.1 Troubleshooting
For information on troubleshooting, refer to this chapter. Refer to our website (https://mimaki.com/support/)
for frequently asked questions (FAQs) about this product and customer support videos.
If the recommended corrective action does not resolve the problem, contact your local dealer or our service
office.

The power does not turn on.

Points to check Corrective action

Is the power cable connected to the
machine?

Insert the power socket until it clicks into place.

Are you using the power cable
provided?

Use the power cable provided.

Is the main power supply turned on? Turn on the main power supply.  "Turning On the Power"(P. 33)

Is the [END/POWER] key on the
operating panel turned on?

Turn the power on.  "Turning On the Power"(P. 33)

Printing is not possible.

Points to check Corrective action

Is a USB interface cable connected? Connect the cable securely to the USB 2.0 port.  "Using a USB
Cable"(P. 37)

Is a LAN cable connected? Connect the cable securely to the LAN port.  "Using a LAN
Cable"(P. 36)

Are you using a LAN cable approved
by Mimaki?

Check the LAN cable type.  "Using a LAN Cable"(P. 36)

Is the status lamp on the operating
panel illuminated or flashing red?

An error has occurred. Check the message on the display. 
"Operating Panel"(P. 30)

The media jams or the media is dirty.

Points to check Corrective action

Are you using the recommended
media?

Make sure you are using the recommended media. https://
mimaki.com/supply/inkjet.html

Are you using curled media? Do not use curled media or media with folded ends.

Is the media skewed? Use the take-up unit to adjust the media or reload the media. 
"Loading the Media"(P. 55)

Image defects occur.

Symptom Corrective action

White streaks, blurriness, and dark
streaks occur.
(Carriage scan direction)

1. Perform the procedure described in  "Head Cleaning"(P. 91).
2. Perform the procedure described in  "Feed Correction"(P. 92).
3. Perform the procedure described in  "Cap Rubber Cleaning"(P. 118).

https://mimaki.com/support/
https://mimaki.com/supply/inkjet.html
https://mimaki.com/supply/inkjet.html
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Symptom Corrective action

4. Perform the procedure described in  "Carriage Underside
Cleaning"(P. 119).

5. Perform the procedure described in  "Cleaning the Feeding
Belt"(P. 147).

Text is double- or triple-printed in the
media feed direction.

1. Perform the procedure described in  "Feed Correction"(P. 92).

Offsetting occurs during bidirectional
printing.

1. Perform the procedure described in  "Correcting the Drop
Position"(P. 94).

Ink droplets drip during printing. 1. Perform the procedure described in  "Cap Rubber Cleaning"(P. 118).
2. Perform the procedure described in  "Carriage Underside

Cleaning"(P. 119).
3. Perform the procedure described in  "Head Cleaning"(P. 91).
4. Set auto maintenance.  "Maintenance Menu"(P. 104)

Nozzles are clogged. 1. Perform the procedure described in  "Head Cleaning"(P. 91).
2. Perform the procedure described in  "Print Head Nozzle

Washing"(P. 167).
3. Perform the procedure described in  "Registering Nozzle

Recovery"(P. 107).

Are the print heads too high? Adjust the print head height.  "Adjusting Print Head Height"(P. 51)
If the print heads cannot be lowered, increase the refresh level of
maintenance during printing (  "Maintenance Menu"(P. 104)) to
Standard or Strong and perform regular test printing to check for
nozzle clogging.

Are there any ink colors that aren't
used much?

Discharge from infrequently used nozzles tends not to be consistent.
Although increasing the refresh level of maintenance during printing
(  "Maintenance Menu"(P. 104)) to Standard or Strong will enable
more frequent nozzle use, note that this will also increase ink
consumption.

Are you using media easily affected
by static electricity?

Increase the refresh level of maintenance during printing (
"Maintenance Menu"(P. 104)) to Standard or Strong and perform
regular test printing to check for nozzle clogging.

Is the machine installed in a location
with low humidity?

Increase the humidity by installing a humidifier or similar equipment.
When printing continuously, also increase the refresh level of
maintenance during printing (  "Maintenance Menu"(P. 104)) to
Standard or Strong and perform regular test printing to check for
nozzle clogging.

Is the machine installed in a location
where dust or powder is present?

Install the machine in a location free of dust or powder (office
equivalent: dust level 0.15 mg/m3).

Print Head Nozzle Washing
If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after head cleaning (
"Head Cleaning"(P. 91)), apply nozzle wash to the print head.

1 On the LOCAL mode screen, select [MENU] > [Maintenance], then press the [ENTER] key.

• The Maintenance menu is displayed.

2 Select [Station Maint.] > [Nozzle Wash], then press the [ENTER] key.

• The carriage moves over the feeding belt.

3 Open the maintenance cover on the right side.

5
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4 Clean the cap rubber.

•  "Cap Rubber Cleaning"(P. 118)

5 Once cleaning is complete, close the cover, then press the [ENTER] key.

• The cap is filled with maintenance liquid.

• Close the cover. The cap cannot be filled with maintenance liquid while the cover is open.
This is also true if the maintenance liquid cartridge is empty.

6 Open the maintenance cover on the right side.

• Check to confirm that the cap is filled with maintenance liquid.

• If not, use a syringe to draw up some maintenance liquid and fill until it almost overflows
from the cap.

7 Close the maintenance covers.

8 Set the exposure time, then press the [ENTER] key.

• Cleaning is performed automatically once print nozzle washing has ended.

• If ejection failures (e.g., nozzle clogging or deflection) remain unresolved even after
washing the nozzles several times, contact your local dealer or our service office.

The ink has leaked out

• If an ink leak occurs, turn off the main power immediately and unplug the power cable. Then,
contact your local dealer or our service office.



Chapter 5 Troubleshooting

169

5.2 Problems Causing Messages to
Appear
If a problem arises, the buzzer sounds and a message appears on the display.
You can also check the local guidance.  "Displaying Machine Information (Local Guidance)"(P. 32)
Take the appropriate action in accordance with the content of the message. If a message reappears even
after taking the prescribed action, contact your local dealer or our service office.

Warning Messages

Message Cause Corrective action

Replace NCU Ink Pad • The ink absorber needs to
be replaced.

• The NCU ink absorber must be
replaced. Contact your local dealer or
our service office.

Replace NCU • A problem was detected
with the nozzle clogging
assessment.

• Clean the NCU.  "NCU
Cleaning"(P. 122)

• Replace the NCU if the error does not
clear. Contact your local dealer or our
service office.

NCU Sensor Lv Low • The sensor's sensitivity is
impaired.

NCU Sens Adj Err H • Sensor sensitivity
adjustment failed.NCU Sens Adj Err L

NCU Connect • A problem was detected
with the NCU connection.

• Turn off the main power and wait a
while before turning back on.

Ink Error • An ink error occurred. • Check the ink error details.  "Ink
Error"(P. 171)

COVER OPEN • The cover is open.
• An emergency stop switch

was pressed.

• Close the cover.
• Reset the emergency stop switch. 

"Emergency Stop Switches"(P. 20)

Data Remain • Print (RIP) data was
received.

• Switch to REMOTE mode and start
printing or clear the data and abort
printing.

Temporary Suspension • Printing has been paused. • Switch to REMOTE mode and resume
printing or clear the data and abort
printing.

Printing not possible/ink IC • An unusable ink IC chip is
used.

• Replace with new ink and a new ink IC
chip.  "Replacing Ink"(P. 42)

Cap Replacement • The cap usage count has
exceeded the specified
amount.

• Replace the cap.  "Cap
Replacement"(P. 157)

Replace Wiper • The wiping count has
exceeded the specified
amount.

• Replace the wiper.  "Wiper
Replacement"(P. 154)

Media Undetected • The media width has not
been detected.

• Detect the media width.  "Loading
the Media"(P. 55)

Wiper Move Failure • The wiper is not operating
correctly.

1. Clean the wiper and around the wiper. 
"Wiper Cleaning"(P. 120)

5
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Message Cause Corrective action

2. Turn off the main power and wait a while
before turning back on.  "Turning Off the
Power"(P. 34)

Replace Wasteinktank • The waste ink tank count
exceeded the specified
value (90%), disabling the
automatic maintenance
function.

1. Check the waste ink levels in the waste ink
tank.  "When "Check Waste Ink Tank"
message appears"(P. 163)

2. Replace the waste ink tank, then reset the
waste ink level.  "Replacing the lower-
left waste ink tank"(P. 163)

Check Waste Ink tank • The waste ink tank count
exceeded the preset
value (80%).

WashLiquidCart.None • No maintenance liquid
cartridge is loaded.

• Load the maintenance liquid cartridge.

Please replace wash liquid
cartridge

• The maintenance liquid
has run out.

• Replace with a new maintenance liquid
cartridge.

Washing liquid end

High ambient temp ** ﾟC • Ambient temperatures are
too high.

• Adjust ambient temperatures to
temperatures within the specified range.
Optimum print quality may not be
possible unless ambient conditions are
within the specified range. 
"Installation Precautions"(P. 17)

Low ambient temp ** ﾟC • Ambient temperatures are
too low.

Auto-correction failed • White media is not used.
• The media is dirty.
• The media lifts up.
• There is dirt around the

sensor.

• Load white and clean media.
• Load media so it does not lift up.
• Clean the area around the sensor. 

"DAS (Automatic Correction Function)
Sensor Cleaning"(P. 123)

• If automatic correction fails repeatedly,
correct the position manually.  "Feed
Correction"(P. 92)  "Correcting the
Drop Position"(P. 94)

Feeding LimitDetect • The feeding tension bar
was detected at the upper
limit position.

• Lower the feeding tension bar.

Feeding Wrong • The feeding tension bar
has not moved from the
lower limit position.

• Press  to feed the media and confirm
that the feeding unit operates correctly.

Check Direct-Connection Unit • Installation of the direct-
connection unit/torque
limiter does not match the
tension bar setting.

• When using tension bars, attach a
direct-connection unit, or otherwise
attach a torque limiter.

Lower Pressure Roller • The pressure roller is
raised when printing is
ready to begin.

• Make sure the pressure roller is
lowered. If this warning is displayed
even when the pressure roller is
lowered, contact your local dealer or
our service office.

Raise Pressure Roller • The pressure roller is
lowered when the power
was turned off or belt
cleaning was executed.

• Make sure the pressure roller is raised.
If this warning is displayed even when
the pressure roller is raised, contact
your local dealer or our service office.



Chapter 5 Troubleshooting

171

Message Cause Corrective action

Check Absorption Roller • It is time to check the
absorption roller water
level.

• Clean the absorption roller.
• Reset the absorption roller counter. 

"Resetting the Counter"(P. 149)

Belt Adhesive 200 m Remain • It is almost time to replace
the adhesive.

• Apply new adhesive.  "Reapplying
Adhesive"(P. 136)

• Reset the adhesive counter. 
"Resetting the Counter"(P. 149)

Reapply Belt Adhesive • It is time to replace the
adhesive.

Peeling error. Check the
media unit position.

• A peeling sensor error
occurred.

• Manually remove any loaded media.
• Use the take-up motor switch to take up

the peeled off media.

Supply Washing Water • Printing stopped because
there is not enough
washing water in the
washing unit.

• Supply washing water to the washing
unit.  "Washing Water
Replacement"(P. 130)

Replace Washing Unit Water • One week has passed
since the washing water
was replaced.

• Drain and supply washing water to the
washing unit.  "Washing Water
Replacement"(P. 130)

To avoid weaker belt cleaning, regularly
replacing washing water in the washing
unit is recommended.

Ink Error

Message Cause Corrective action

Ink End • The ink has run out. • Replace with new ink.  "When Ink
End is Displayed"(P. 41)

• If you use UISS, you may perform
cleaning.

Ink Near End • Ink levels are low. • The ink will run out soon. Have new ink
ready.  "When Ink Near End is
Displayed"(P. 41)

Non Ink IC • No ink IC chip was
detected.

1. Insert the ink IC chip.  "Replacing
Ink"(P. 42)

2. Check to confirm the ink IC chip was
inserted correctly.  "Mounting the
ink"(P. 45)

3. Turn off the main power and wait a while
before turning back on.  "Turning Off the
Power"(P. 34)

Wrong Ink IC • An error occurred with the
information on the ink IC
chip.

1. Check to confirm the ink IC chip was
inserted correctly.  "Mounting the
ink"(P. 45)

2. Turn off the main power and wait a while
before turning back on.  "Turning Off the
Power"(P. 34)

3. Replace with new ink.  "Replacing
Ink"(P. 42)

Ink Color • The ink color registered
on the IC chip is different
from the ink color filled.

• Insert an ink IC chip for the correct ink
color.  "Mounting the ink"(P. 45)

5
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Message Cause Corrective action

Ink Type • The ink type registered on
the IC chip is different
from the ink type filled.

• Insert an ink IC chip for the correct ink
type.  "Mounting the ink"(P. 45)

Expiration Near • The ink has expired.
• The ink is one month past

its expiration date.

• Replace with new ink or use up as
quickly as possible. Printing is possible.

 "When Ink End is Displayed"(P. 41)

Expiration Over • The ink is two months
past its expiration date
and cannot be used.

• Replace with new ink. Printing is not
possible.  "When Ink End is
Displayed"(P. 41)

Error Message

Error
number

Message Cause Corrective action

04 PARAM ROM • A problem was detected
with the main PCB.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)108 HD CONNECT[12] • A problem was detected

with the print head
connection.

108 HD MEM EMP[12] • A problem was detected
with the print head.

10e FROM CLEAR • A problem was detected
with the main PCB.10f FROM WRITE

115 PCB MAIN-F1

122 CHECK:SDRAM • A problem was detected
with the SDRAM.122 PRAM NONE

123 PRAM DATA • A problem was detected
with the main PCB.124 PRAM ADDR

127 POWER OFF

128 HDC FIFO OVER /
HDC FIFO UNDER

• A problem was detected
with the print head control
PCB.

129 Battery Exchange • The internal clock battery
is spent and must be
replaced.

• Contact your local dealer or our
service office.

12a HDC SPEED • A problem was detected
with the print head control.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)12d PCB MAIN-F4 • A problem was detected

with the main PCB.

130 HD DATA SEQ • A problem was detected
with the print head control.

147 DS-IC BUSY • Ink IC control abnormality
detected.

148 E-LOG SEQ • A log control abnormality
was detected.
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Error
number

Message Cause Corrective action

151 Main PCB V1R2 • A problem was detected
with the main PCB power
supply circuit.152 Main PCB V2R5

153 Main PCB V3R3

154 Main PCB V05

155 Main PCB V42-1

15f HEAD DRIVE HOT • The HDCE PCB COM
driver is hot.

171 NEW HEAD CONNECT • A new print head
connection was detected.

186 HDC OVERFLOW/HDC
UNDERFLOW

• A problem was detected
with the print head control.

187 HDC SLEW RATE

188 HDC MEMORY

18c Main PCB V12 • A problem was detected
with the main PCB power
supply circuit.

18e FLS NOT COMP • A problem was detected
with the print head control.18f OFFSET START / END

[12]

1b5 SLIDER CONNECT • The HDCE PCB could not
be detected.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)1bf PCB MAIN-F2 • A problem was detected

with the main PCB.

1d8 HEAD XHOT[12] • A problem was detected
with the print head.

1e6 PRAM Size Shortage • Insufficient memory

201 Command Error • Data other than print (RIP)
data was received, or a
problem was detected
with the print (RIP) data
received.

1. Clear the data and resend.
2. Check the USB/Ether cable connection.

 "Connecting a PC to the
Product"(P. 36)

3. Use a compatible cable. 
"Connecting a PC to the Product"(P. 36)

4. Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

202 Parameter Error • A problem was detected
with the print (RIP) data
received.

206 Print Mode Error • Print (RIP) data was
received with print
parameters that do not
allow printing.

• Change the output parameters and
profile using RIP software.

20A Driver Version • Printing is not possible
because the Mimaki driver
version is old.

• Install the latest Mimaki driver
available from: 
https://mimaki.com/download/
inkjet.html

303 PCB MAIN ET • A problem was detected
with the main PCB.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

5
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Error
number

Message Cause Corrective action

304 USB INIT ERR • A problem was detected
with the USB cable
connection.

1. Check the USB cable connection. 
"Using a USB Cable"(P. 37)

2. Use a compatible cable.  "Using a
USB Cable"(P. 37)

3. Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

305 USB TIME OUT

318 SDcard Connection
ERR

• A problem was detected
with the SD card.

1. Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

401 Motor X • The X motor was
overloaded.

1. Check to confirm the media is loaded
correctly.  "Loading the
Media"(P. 55)

2. Open the front cover and check for
anything that may obstruct carriage
movement.

3. Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

402 Motor Y • The Y motor was
overloaded.

403 X Current • An overcurrent error was
detected in the X motor.

404 Y Current • An overcurrent error was
detected in the Y motor.

406 Wiper Move Failure • The wiper origin could not
be detected.

1. Clean the wiper and around the wiper.
 "Wiper Cleaning"(P. 120)

2. Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

424 Feed tension bar • Feeding tension bar
position initialization
failed.

1. Lower the feeding tension bar.
2. Check which way the feeding unit

rotation direction switch is set. 
"Feeding unit"(P. 60)

3. Check to confirm the media is loaded
correctly.

426 Feeding Wrong • The feeding tension bar
has not moved from the
lower limit position.

1. Check which way the feeding unit
rotation direction switch is set.

2. Check to confirm the media is loaded
correctly.

42a Feeding LimitDetect • The feeding tension bar
was detected at the upper
limit position.

1. Lower the feeding tension bar.
2. Check which way the feeding unit

rotation direction switch is set. 
"Feeding unit"(P. 60)

3. Check to confirm the media is loaded
correctly.

44f Take-up Roll Sns Err • A problem was detected
with the take-up unit
sensor spindle.

1. Check to confirm the [Function Setting]
> [Option Roll Unit Select] > [Take-up
Unit] setting is "ON"  "Function
Setting Menu"(P. 109)

2. Check to confirm the media is loaded
correctly.  "Loading the Roll
Media"(P. 66)

3. Check to confirm the take-up unit switch
functions properly.  "Take-up
unit"(P. 56)

450 Feeding Roll Sns Err • A problem was detected
with the feeding unit
sensor spindle.

1. Check to confirm the [Function Setting]
> [Option Roll Unit Select] > [Feeding
Unit] setting is "ON".  "Function
Setting Menu"(P. 109)
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Error
number

Message Cause Corrective action

2. Check to confirm the media is loaded
correctly.  "Loading the Roll
Media"(P. 66)

3. Check to confirm the feeding unit switch
functions properly.  "Feeding
unit"(P. 60)

46d Wash Unit Org • Cannot detect the
washing unit origin.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

• If this message is displayed again,
contact your local dealer or our
service office.

46f Peel Sensor • Failed to detect the
peeling sensor (slack
sensor).

1. Manually take up the media so that no
media is over the peeling sensors.

2. Confirm that the take-up motor rotation
direction switch is set to the correct
direction.

• If this message is displayed again,
contact your local dealer or our
service office.

470 Peeling warn • Error during peeling
(sensor ON/OFF detected
continuously).

1. Make sure that both edges of the media
can be peeled off evenly.

2. Confirm that the take-up motor rotation
direction switch is set to the correct
direction.

3. Manually peel off the media and take it
up with the take-up switch.

471 Media Involvement • Peeling sensor EM
(bottom sensor) detection.

1. Make sure the media has not been
taken up to an area near the washing
unit.

2. Confirm that the take-up motor rotation
direction switch is set to the correct
direction.

3. Manually peel off the media and take it
up with the take-up switch.

472 Displace Sensor ORG. • Cannot detect the
correction unit
displacement sensor
origin.

1. Confirm that belt correction is set to
"ON."  "Media Setting Menu"(P. 102)

2. Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

• If this message is displayed again,
contact your local dealer or our
service office.

473 Grip Slip • During feeding, the
correction unit grip section
origin did not go off, or the
displacement sensor is
not responding.

1. Clean adhesive off the right edge of the
feeding belt.

2. Clean adhesive off the belt correction
unit rubber gripper.  "Belt Correction
Unit Cleaning"(P. 127)

3. Manually peel off the media and take it
up with the take-up switch.

• If this message is displayed
repeatedly, contact your local dealer
or our service office.

475 Belt Comp. Error • Incorrect value of the belt
correction unit
displacement sensor.

5
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Error
number

Message Cause Corrective action

48b Y MOTOR COM • Y motor communication is
not possible.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)48c Y MTR I2C COM • Y motor communication is

not possible at startup.

496 Y MOTOR DIR • The Y motor operating
direction cannot be
specified.

505 Media Jam • The media jam sensor
was triggered.

1. Remove the media in contact with the
carriage and reload with fresh media.

 "Loading the Media"(P. 55)
2. Open the front cover and check for

anything that may obstruct carriage
movement.

507 HEADHEIGHT ERR • A problem was detected in
head height (Low to High)
acquisition.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

509 HDC POSCNT • A problem was detected
with position control.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)50a Y Org Detect Error • A problem was detected

with Y origin detection
(initialization).

50f L-SCALE BLACK • A problem was detected
with the linear scale.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

516 Media Set Position R
(L)

• The media was loaded
outside the range of valid
positions.

1. Check the media loading position. 
"Loading the Media"(P. 55)

2. Clean the DAS sensor.  "DAS
(Automatic Correction Function) Sensor
Cleaning"(P. 123)

530 Station Origin • The station control origin
is not set.

• Contact your local dealer or our
service office.

53e Wash Liquid Full • The belt washing tray is
full of water.

1. Adjust the flow rate of the washing
water.

2. Check if the washing water discharge
channel is clogged.

53f Check Wash liquid • There is little water in the
belt washing tray.

• Add water to the belt washing tray.

54d HDCE Cooling Fan Err • An HDCE cooling fan
rotation abnormality was
detected.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

602 Ink End • The ink has run out. • Replace with new ink.  "When
Ink End is Displayed"(P. 41)

608 Wrong Ink IC • An error occurred with the
information on the ink IC
chip.

1. Check to confirm the ink IC chip was
inserted correctly.  "Mounting the
ink"(P. 45)

2. Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

3. Replace with new ink.  "Replacing
Ink"(P. 42)
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Error
number

Message Cause Corrective action

60a Excess Ink Usage • The ink usage amount
stored in the ink IC chip
exceeded the preset
value.

• The ink IC chip was not
replaced during ink
replacement. (The same
chip continued to be
used.)

• Replace with new ink.  "When
Ink End is Displayed"(P. 41)

60c Ink Type • The ink type registered on
the IC chip is different
from the ink type filled.

• Insert an ink IC chip for the correct
ink type.  "Mounting the
ink"(P. 45)

629 Expiration Near • The ink has expired.
• The ink is one month past

its expiration date.

• Replace with new ink or use up as
quickly as possible. Printing is
possible.  "When Ink End is
Displayed"(P. 41)

62a Expiration Over • The ink is two months
past its expiration date
and cannot be used.

• Replace with new ink. Printing is not
possible.  "When Ink End is
Displayed"(P. 41)

631 Ink Color • The ink color registered
on the IC chip is different
from the ink color filled.

• Insert an ink IC chip for the correct
ink color.  "Mounting the
ink"(P. 45)

637 INK LEAK _ • The ink leak sensor
detected an ink leak.

• Contact your local dealer or our
service office.

801 (C) OPCODE • A problem was detected
with the main PCB.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)802 (C) SWI

803 (C)PFTCHABRT

804 (C)DATAABRT

806 FW/SIO bit • A communication error
was detected between the
boards.

808 FW/STP-MTR** • A problem was detected
with the main PCB.

80f FW/SIO Vch • A communication error
was detected between the
boards.811 FW/SIO read ****

81b FW/STACK OV • A problem was detected
with the main PCB.828 PRG ERR L*****

901 Operation Error • The function is disabled
due to an error.

• Check the error details.

902 Data Remain • Print (RIP) data was
received.

• Switch to REMOTE mode and start
printing or clear the data and abort
printing.

90f Print Area Short • The media is too small for
the print.

• Replace with wider or longer media.
• If the printable area is reduced due

to a shift in the origin, move the
origin to increase the size of the
printable area.
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Error
number

Message Cause Corrective action

b1a PCB BaseIO1 • A communication error
was detected between the
boards.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)b1a PCB BaseIO2

b1b BaseIO PCB Vpow-s • A problem was detected
with the Base IO PCB
power supply.b1c BaseIO PCB V24

b1e PCB BaseIO-F** • The Base IO PCB fuse
blow was detected.

• The fuse must be replaced. Contact
your local dealer or our service
office.

b36 PCB INKIO • A communication error
was detected between the
boards.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)

b3f BaseIO Unconform • The PCB could not be
detected.

b48 PCB HDCE* • A communication error
was detected between the
boards.

b49 PCB HDCE-
VHVFET[12]

• A problem was detected
with the HDCE PCB
power supply.

b4a PCB HDCE*-F* • A blown fuse on the
HDCE PCB was detected.

• Contact your local dealer or our
service office.

b4b HDCE* PCB V1R2 • A problem was detected
with the HDCE PCB
power supply.

• Turn off the main power and wait a
while before turning back on. 
"Turning Off the Power"(P. 34)b4c HDCE* PCB V2R5

b4d HDCE* PCB V3R3

b51 BaseIO PCB V24adj • A problem was detected
with the Base IO PCB
power supply.

d1b COM VOLT[12] • A problem was detected
with the HDCE PCB
voltage.

SYSTEM HALT

• If a SYSTEM HALT number is displayed, turn off the main power and wait a while before turning
back on.
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6.1 Specifications
Item Tx330-1800B

Print
head

Type On-demand piezo head

Specifications Two staggered heads with 400 nozzles × 8 rows each

Resoluti
on

Y 300 dpi, 600 dpi

X 600 dpi, 900 dpi, 1,200 dpi, 1,800 dpi

Ink Type Sb420, TP410

Ink set Sb420 4-color: M, Bl, Y, K
6-color: C, M, Bl, Y, K, Lb, Lm

TP410 4-color: M, C, Y, K
8-color: M, C, Y, K, R, G, Bl, Lk

Hybrid Sb420: M, Bl, Y, K / TP410: M, C, Y, K

Media Type Cloth

Maximum printing
width*1

1,890 mm

Maximum width 1,900 mm

Minimum width 210 mm

Thickness Max. 5.0 mm

Roll external
diameter*2

Max. 250 mm

Roll weight*2, 3 Max. 40 kg (2 to 3-inch paper core)
Max. 34 kg (1 to 1.5-inch paper core)

Paper core
internal diameter

1 to 1.5 inches, 2 to 3 inches

Printing face Exterior/interior

Roll end Taped or loosely affixed to paper core

Print
margins

Left/right 15 mm (default), minimum: 5 mm

Distanc
e
accurac
y*4

Absolute
accuracy

±0.3 mm or ±0.3 % of specified distance, whichever is greater

Duplicability ±0.2 mm or ±0.1 % of specified distance, whichever is greater

Perpendicularity ±5 mm/1,000 mm

Media skew Not more than 5 mm/10 m

Printing gap Manual, five settings (3.0–7.0 mm)

Origin alignment LED pointer

Ink supply Ink eco-case (ink pack)

Maintenance liquid feed Cartridge

Waste Ink Tank Bottle type (2,000 ml)

Take-up unit Provided



Chapter 6 Appendix

181

Item Tx330-1800B

Feeding unit Provided

Media heater -

NCU (Nozzle clogging
detection)

Provided

DAS (Automatic correction
function)

Provided

Interfac
e

Data transfer
function

Ethernet 1000BASE-T (recommended)*5, 6, USB 2.0 Hi-speed *6, 7

Command MRL-V

Languages English, Japanese, Chinese, Turkish, Portuguese, Spanish, Italian, Korean

Noise
levels

During standby Not more than 52 dB (FAST-A, 1 m on all sides)

Continuous
operation

Not more than 56 dB (FAST-A, 1 m on all sides)

Non-continuous
operation

Not more than 65 dB (FAST-A, 1 m on all sides)

Compliance with standards VCCI Class A, FCC Class A, IEC 62368-1 ETL compliance, CE marking
(EMC Directive, Low Voltage Directive, Machinery Directive, RoHS Directive),
CB certified, REACH, EnergyStar, RCM marking, KC certified, UKCA marking

Power supply
specifications*8

Single-phase 100 to 120V AC / 200 to 240 V AC ±10%/5 A, 
50/60 Hz ±1 Hz

Power
consum
ption

Maximum*9 300 W or less

Standard 190 W

Minimum*10 4.5 W or less

Installati
on
environ
ment*11

Permissible
ambient
temperature

20 to 30 °C

Relative humidity 35 to 65 %RH (no condensation)

Temperature
range in which
accuracy is
guaranteed

20 to 25 °C

Temperature
gradient

Not more than ±10 °C/h

Dust 0.15 mg/m3 (typical office)

Maximum
operating altitude

2,000 m

External
dimensi
ons*12

Width 3,230 mm (3,430 mm)

Depth 1,912 mm (1,140 mm)

Height 1,900 mm (2,200 mm)

6
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Item Tx330-1800B

Weight*12 622 kg (848 kg)

*1. With setup menu margins set to the minimum (5 mm) on either side.
*2. External diameter and weight after winding media.
*3. Free of sagging due to weight.
*4. Excluding media size variation and initial loading fluctuations.
*5. Printing is not possible if local guidance shows any speed other than "1000Mbps". Using a LAN Cable
*6. The print speed may be decreased depending on the connection environment or print data. Connecting a

PC to the Product
*7. Data may be transferred to the machine too slowly, causing the carriage to pause at the left-hand or right-

hand end during printing.
*8. Excluding options.
*9. Varies depending on print mode.

*10. In sleep.
*11. Ink ejection consistency may decrease in conditions outside this range.
*12. The figures in parentheses indicate package dimensions.
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6.2 Options
Name Code Reference

Small Relay Box OPT-J0370

Relay Box 2 OPT-J0407

Slip Sheet Holder Unit B OPT-J0431

OPT-DsubBKT OPT-01012

Drying Fan Connection Kit OPT-J0512

Relay Box

• A fire may occur if another manufacturer's external drying heater is used. Be sure to connect to
the machine using either the compact relay box or relay box 2 specified as options.

• The Tx330-1800B allows only one relay box (OPT-J0370 or OPT-J0407) to be connected.

• The optional connection relay cable (OPT-J0512 drying fan connection kit) and the mounting
bracket (OPT-01012 OPT-DsubBKT) are required when using a relay box.

l Overview
The relay box switches the heater power on and off automatically in conjunction with the machine
operations.

• The heater is turned off when printing stops to prevent heating while the machine is not moving.
• The relay box cannot function to control the temperature of an external drying heater. The temperature

should be set on the external heater itself.

l Specifications
Small relay box (OPT-J0370) Power

supply
specificatio

ns

Single-phase 100 V to 120 V AC, 12 A, single-phase
200 V to 240 V AC, 8 A, 50/60 Hz, single-circuit main
power supply

Type Resistance heater or electric heater using lamp

Relay box 2 (OPT-J0407) Power
supply

specificatio
ns

Single-phase 100 V to 240 V AC, 30 A, 50/60 Hz,
single-circuit main power supply

Type Resistance heater or electric heater using lamp

6
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Index
A

Absorption Roller ..................................................................................................................................  113, 133

Adhesive.......................................................................................................................................................  113

Adjust Waste Ink Volume .............................................................................................................................  163

Air PG...........................................................................................................................................................  106

Auto Cleaning...............................................................................................................................................  105

Auto Maint. .....................................................................................................................................  24, 104, 105

Auto Nozzle Recovery..................................................................................................................................  105

Auto Power-off..............................................................................................................................................  109

Auto Power-on..............................................................................................................................................  109

Auto Remote ................................................................................................................................................  110

Auto-correction (DAS) ..........................................................................................................................  102, 170

B

Belt Adhesive ...............................................................................................................................................  106

Belt Cleaning ................................................................................................................................................  106

Belt Maintenance..........................................................................................................................................  106

Belt Washing Unit ...................................................................................................................................  24, 106

Blowing fan.....................................................................................................................................  26, 129, 161

C

Cancel ............................................................................................................................................................  30

Cap.........................................................................................................................................  28, 117, 118, 157

Cap absorber................................................................................................................................................  159

Cap Replacement.................................................................................................................................  104, 113

Capping Use Days .......................................................................................................................................  113

Carriage......................................................................................................................  24, 28, 30, 104, 117, 119

Carriage Out .................................................................................................................................................  104

Cleaning .................................................................................................................................................  91, 104

Cloth-wound roller ....................................................................................................................................  25, 26

Color profile ....................................................................................................................................................  39

Connection relay cable.................................................................................................................................  183

Counter Reset ..............................................................................................................................................  106

Curved bar......................................................................................................................................................  26

Custody Wash ......................................................................................................................................  104, 150

D

DAS (Dot Adjustment System) .....................................................................................................  102, 117, 123

Delete MediaInfo ..........................................................................................................................................  103
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Detail Setting ................................................................................................................................................  103

DISCLAIMERS .................................................................................................................................................  6

Display............................................................................................................................................................  30

Display language..........................................................................................................................................  111

Doctor .............................................................................................................................................................  24

Drop.PosCorrect.........................................................................................................................  32, 49, 94, 102

Drying Time ..................................................................................................................................................  109

E

Ejection failures ................................................................................................  89, 91, 104, 107, 120, 157, 166

[END/POWER] key.............................................................................................................................  29, 30, 34

[ENTER] key...................................................................................................................................................  30

Environment Setting Menu ...........................................................................................................................  111

Error........................................................................................................................................................  30, 169

Error History .................................................................................................................................................  113

F

FCC ..................................................................................................................................................................  6

Feed Comp.................................................................................................................................  32, 49, 92, 102

Feed Speed..................................................................................................................................................  103

Feeding belt....................................................................................................................................................  25

Feeding tension bar........................................................................................................................................  26

Feeding unit..............................................................................................................................................  26, 60

Front cover .....................................................................................................................................................  24

[FUNCTION] key ......................................................................................................................................  30, 32

Function Setting Menu .................................................................................................................................  109

H

Head Cleaning................................................................................................................................................  30

Head height ....................................................................................................................................................  51

Heater.............................................................................................................................................................  29

Height adjustment lever..................................................................................................................................  51

I

Ink absorber ...........................................................................................................................................  43, 162

Ink discharge channel ..................................................................................................................................  124

Ink Eco-case.......................................................................................................................................  42, 44, 45

Ink End ...................................................................................................................................................  41, 106

Ink Error..........................................................................................................................................................  31

Ink IC chip ..........................................................................................................................................  42, 43, 46

Ink IC chip slot ................................................................................................................................................  46

INK NEAR-END..............................................................................................................................................  41
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Ink pack ....................................................................................................................................................  42, 43

Ink replacement ............................................................................................................................................  113

Ink status ........................................................................................................................................................  31

Ink Supply Unit .......................................................................................................................................  43, 162

Inlet...........................................................................................................................................................  26, 33

Installation guide ......................................................................................................................................  39, 40

Installation Space ...........................................................................................................................................  18

Interference ......................................................................................................................................................  6

interlock ..........................................................................................................................................................  19

J

Jam sensor .....................................................................................................................................  24, 117, 126

[JOG] key .......................................................................................................................................................  30

Judgment Condition .....................................................................................................................................  105

K

Key Buzzer ...................................................................................................................................................  111

KeyLife .........................................................................................................................................................  112

L

LAN cable.................................................................................................................................................  26, 36

LAN port .........................................................................................................................................................  26

LANGUAGE .................................................................................................................................................  111

List ................................................................................................................................................................  113

Local guidance ...............................................................................................................................................  32

LOCAL mode............................................................................................................................................  30, 31

Logical Seek.................................................................................................................................................  109

M

Machine Status Menu...................................................................................................................................  113

Main power switch..............................................................................................................................  26, 29, 33

Maintenance.................................................................................................................................................  113

Maintenance cover .........................................................................................................................................  24

Maintenance History.....................................................................................................................................  113

Maintenance liquid absorber ........................................................................................................................  159

Maintenance liquid cartridge ..........................................................................................................................  26

Maintenance Menu.......................................................................................................................................  104

MAPS (Mimaki Advanced Pass System) .....................................................................................................  102

Margin ..........................................................................................................................................................  110

Media..............................................................................................................................................................  55

Media feed......................................................................................................................................................  30

Media Information.........................................................................................................................................  103
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Media Name Change ...................................................................................................................................  103

Media Remain ..............................................................................................................................................  103

Media Setting Menu .....................................................................................................................................  102

MENU mode...................................................................................................................................................  31

Mimaki driver ..................................................................................................................................................  39

MRA (Mimaki Remote Access).....................................................................................................................  111

N

NCU (Nozzle Check Unit).............................................................................................................................  122

Network ........................................................................................................................................................  111

NOT-READY mode ........................................................................................................................................  31

Nozzle Check ...............................................................................................................................................  108

Nozzle clogging ......................................................................................................................................  91, 108

Nozzle Deflection ...........................................................................................................................................  91

Nozzle Recovery ..................................................................................................................................  104, 107

Nozzle Wash ........................................................................................................................................  104, 167

O

Operating Panel .......................................................................................................................................  24, 30

Option Roll Unit Select .................................................................................................................................  109

P

Peeling roller ..................................................................................................................................................  24

PIN code.......................................................................................................................................................  112

Power cable....................................................................................................................................................  33

Power outlet ...................................................................................................................................................  33

Power plug .....................................................................................................................................................  33

Power Setting ...............................................................................................................................................  109

Pre Feed.......................................................................................................................................................  103

Pressure roller ................................................................................................................................................  26

Print Area .....................................................................................................................................................  113

Print Length ..................................................................................................................................................  113

Print Maint. ...................................................................................................................................................  105

Print origin ......................................................................................................................................................  98

Pump Tube Cleaning............................................................................................................................  104, 124

R

RasterLink ....................................................................................................................  39, 40, 96, 97, 109, 110

Receive buffer ..............................................................................................................................................  100

Reference guide .............................................................................................................................................  97

Refresh.........................................................................................................................................................  106

Relay box .....................................................................................................................................................  183
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Remaining ink.................................................................................................................................................  31

Remote Control ............................................................................................................................................  111

REMOTE mode ........................................................................................................................................  30, 31

Replace Water..............................................................................................................................................  106

Replace Wiper ..............................................................................................................................  104, 113, 154

Reversing bar .................................................................................................................................................  26

Roll holder setting position label.....................................................................................................................  65

S

[SEL] key ........................................................................................................................................................  30

Smoothing Level...........................................................................................................................................  103

Smoothing roller .............................................................................................................................................  26

Station ......................................................................................................................................................  24, 28

Station Maint. ...............................................................................................................................................  104

Status lamp ....................................................................................................................................................  30

Switching hub .................................................................................................................................................  36

Symbol .............................................................................................................................................................  8

SYSTEM HALT ..............................................................................................................................................  30

T

Take-up diameter detection..........................................................................................................................  109

Take-up unit .............................................................................................................................................  24, 56

Test Printing .....................................................................................................................................  30, 89, 104

Time Set .......................................................................................................................................................  111

Top Blower ...................................................................................................................................................  110

U

Unit Setting...................................................................................................................................................  111

Usage ...........................................................................................................................................................  113
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USB port .........................................................................................................................................................  26
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V
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W

Warning Label ................................................................................................................................................  21
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Wiper cleaner ...............................................................................................................................................  155
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